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About This Guide

This Novell ZENworks 11 SP3 Asset Inventory Reference includes information to help you successfully
perform inventory tasks. The information in this guide is organized as follows:

*

*

*

Chapter 1, “overview,” on page 9

Chapter 2, “Scanning Managed Devices,” on page 11
Chapter 3, “Scanning Inventory Only Devices,” on page 31
Chapter 4, “Scanning Demographic Data,” on page 45
Chapter 5, “Importing Demographic Data,” on page 63
Chapter 6, “Creating Local Software Products,” on page 73
Chapter 7, “Using Administrator-Defined Fields,” on page 85
Chapter 8, “Using Reports,” on page 89

Chapter 9, “Managing Component Data,” on page 103
Chapter 10, “Managing Product Data,” on page 107

Chapter 11, “Purge Inventory History,” on page 113
Appendix A, “Inventory Workflow,” on page 117

Appendix B, “Troubleshooting Asset Inventory,” on page 119
Appendix C, “Documentation Updates,” on page 127

Audience

This guide is intended for Novell ZENworks administrators.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation
included with this product. Please use the User Comments feature at the bottom of each page of the
online documentation.

Additional Documentation

ZENworks 11 SP3 with Asset Inventory is supported by other documentation (in both PDF and
HTML formats) that you can use to learn about and implement the product. For additional
documentation, see the ZENworks 11SP3 documentation Web site (http://www.novell.com/
documentation/zenworks113).

About This Guide
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1.1

1.2

1.3

overview

Novell ZENworks 11 SP3 Asset Inventory allows you to take an inventory of all the devices in your
Management Zone, including data on hardware, software, and demographics.

The following sections contain additional information:

¢ Section 1.1, “Scanning for Hardware Information,” on page 9
¢ Section 1.2, “Scanning for Software Information,” on page 9
¢ Section 1.3, “Scanning for Demographic Information,” on page 9

¢ Section 1.4, “Security Considerations,” on page 10

Scanning for Hardware Information

Asset Inventory allows you to scan and collect hardware data for all the devices in your Management
Zone. The hardware data includes information about keyboard, video adapter, bus adapter, monitor,
CD/DVD, LAN adapter, diskette, hard drive, memory module, parallel port, printer, mouse, BIOS,
serial port, system board, processor, USB keyboard and USB port. You might also find other
categories of hardware components apart from the ones listed. The unrecognized hardware
components are listed as Other Hardware in the inventory scan report. You can view the collected
hardware data in several ways by using standard and custom reports.

Scanning for Software Information

Asset Inventory allows you to scan all the devices in your Management Zone and collect data on
what software products are installed on those devices. Asset Inventory can identify thousands of
products and allows you to define additional products so that they can be recognized on subsequent
scans and on other devices. It also allows you to collect data on how many virtual machines are
present on the device. Data can be displayed through a variety of reports. This data can be used for
general information, license compliance, and so on.

Scanning for Demographic Information

Asset Inventory allows you to collect demographic information by using one of the following:

¢ Collection Data Form: You can poll workstation users for demographic data, such as name,
phone number, department, cost center, and so on. This information is added to the inventory
data, giving you a complete picture of all the devices in your Management Zone.

¢ LDAP Import Tasks: You can import demographic data from Microsoft Active Directory and
Novell eDirectory to the Novell ZENworks database. You can set up tasks for different Active
Directory or e-Directory LDAP sources, and schedule each task individually.

overview

9



1.4 Security Considerations

No integrity protection is provided for inventory data because it is collected from agents. Because
access to inventory data could provide information on how to attack a machine in the Management
Zone, Asset Inventory should only be used in a secure environment. In addition, the database where
the inventory data is stored should also be protected.

To avoid security threats, Windows managed devices have restricted permissions when accessing
network drives for the processes which run in System context. The ZENworks Adaptive Agent can
detect Network drives only with administrator privilege access.
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Scanning Managed Devices

An inventory scan of your managed devices provides you with a detailed report of each device’s
hardware, software, and demographic data. The following sections provide information on inventory
scans:

¢ Section 2.1, “Configuring an Inventory Scan,” on page 11

¢ Section 2.2, “Scheduling an Inventory Scan,” on page 16

¢ Section 2.3, “Running an Inventory Scan,” on page 25

¢ Section 2.4, “Adding Hardware Products from ZENworks Control Center,” on page 26

¢ Section 2.5, “Viewing an Inventory Report for a Managed Device,” on page 27

¢ Section 2.6, “Editing a Managed Device’s Inventory Data,” on page 30

2.1 Configuring an Inventory Scan

An inventory scan allows you to collect data from managed devices in your Management Zone. By
default, the inventory settings are preconfigured.

You can define the scan settings at three levels:

¢+ Management Zone: The settings are inherited by all device folders and devices. To configure a
scan for the management zone, see Section 2.1.1, “Configuring a Scan for the Management
Zone,” on page 11.

¢ Device Folder: The settings are inherited by all devices contained within the folder or its
subfolders. Overrides the Management Zone settings. To configure a scan for the devices in a
folder, see Section 2.1.2, “Configuring a Scan for Devices in a Folder,” on page 15.

¢ Device: The settings apply only to the device for which they are configured. Overrides the
settings at the Management Zone level and the device folder level. To configure a scan for a
device, see Section 2.1.3, “Configuring an Inventory Scan for a Device,” on page 15.

2.1.1 Configuring a Scan for the Management Zone

1 In ZENworks Control Center, click Configuration, then in the Management Zone Settings panel,
click Inventory.

2 Click Inventory in the category list.

3 In the Scan Now panel, configure how to run an on-demand inventory scan by using a Quick
Task, device task, or by using the ZENworks Icon menu.

For more information on running an on-demand inventory scan, see Section 2.3, “Running an
Inventory Scan,” on page 25.

Scanning Managed Devices 11
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»

Scan Now

[ collect Software Applications Collect Hardware  [JLaunch Collection Data Form User Can Initiate Scan
[ collect Software File Information [T Run DMTF Translator [Jcollect #sI infarmation

Collect Software Applications: Select this option if you want to scan for software applications.
This setting is selected by default.

Collect Software File Information: Select this option if you want to scan for software file
information that can be used to identify software products that aren’t recognized by the
ZENworks Knowledgebase. If you plan to create Local Software Products and add them to the
knowledgebase, this option must be selected. For more information, see Chapter 6, “Creating
Local Software Products,” on page 73.

Collect Hardware: Select this option if you want to scan for hardware data. This setting is
selected by default.

Launch Collection Data Form: Select this option if you want to send out the Collection Data
Form, which is used to collect demographic data. For more information, see Chapter 4,
“Scanning Demographic Data,” on page 45.

Run DMTF Translator: Select this option if you want to run the DMTF (Desktop Management
Task Force) Translator. The DMTF translator converts the inventory data to formats that can be
used by other tools and puts it on the local machine.

User Can Initiate Scan: Select this option if you want to allow the workstation user to initiate a
scan by using the ZENworks Icon.

Collect MSI Information: Select this option if you want to scan for information about the
installed Microsoft Installer (MSI) files that are used for installation, storage, and removal of
programs on a device.

In the First Scan panel, configure how you want to run an initial inventory scan on a device.

»

First Scan

Ml collect Software Applications Ml collect Hardware [ Launch Collection Data Form
O callect software File Information [ Run DMTF Translator O callect ts! Infarmation

Collect Software Applications: Select this option if you want to scan for software applications.
This setting is selected by default.

Collect Software File Information: Select this option if you want to scan for software file
information that can be used to identify software products that aren’t recognized by the
ZENworks Knowledgebase. If you plan to create Local Software Products and add them to the
knowledgebase, this option must be selected. For more information, see Chapter 6, “Creating
Local Software Products,” on page 73.

Collect Hardware: Select this option if you want to scan for hardware data. This setting is
selected by default.

Launch Collection Data Form: Select this option if you want to send out the Collection Data
Form, which is used to collect demographic data, when a scan is initiated. For more information,
see Chapter 4, “Scanning Demographic Data,” on page 45.

Run DMTF Translator: Select this option if you want to run the DMTF (Desktop Management
Task Force) Translator. The DMTF translator converts the inventory data to formats that can be
used by other tools and puts it on the local machine.

Collect MSI Information: Select this option if you want to scan for information about the
installed Microsoft Installer (MSI) files that are used for installation, storage, and removal of
programs on a device.

ZENworks 11 SP3 Asset Inventory Reference



5 In the Recurring Scan panel, configure how you want to run scans based on a schedule.

»

Recurring Scan

Collect software Applications Callect Hardware [ Launch Callection Data Form
O collect software File Information [ Run DMTF Translator Olcallect Msl Infarmation

Collect Software Applications: Select this option if you want to scan for software applications.
This setting is selected by default.

Collect Software File Information: Select this option if you want to scan for software file
information that can be used to identify software products that aren’t recognized by the
ZENworks Knowledgebase. If you plan to create Local Software Products and add them to the
knowledgebase, this option must be selected. For more information, see Chapter 6, “Creating
Local Software Products,” on page 73.

Collect Hardware: Select this option if you want to scan for hardware data. This setting is
selected by default.

Launch Collection Data Form: Select this option if you want to send out the Collection Data
Form, which is used to collect demographic data. For more information, see Chapter 4,
“Scanning Demographic Data,” on page 45.

Run DMTF Translator: Select this option if you want to run the DMTF (Desktop Management
Task Force) Translator. The DMTF translator converts the inventory data to formats that can be
used by other tools and puts it on the local machine.

Collect MSI Information: Select this option if you want to scan for information about the
installed Microsoft Installer (MSI) files that are used for installation, storage, and removal of
programs on a device.

6 In the Software Applications panel, configure which directories to skip.
Software Applications

Skip Directories:
Add

» Edit
ChARecycled Remove
CARecycler
CASystem Yolume Infarmation
Chaindowsinstaller
Chwindows\FegisteredPackages
Chwindows\ ServicePackFiles\i3gs
CAWindows\$MT ServicePackUninstall$ v

Skipping directories is useful in limiting the scope of the scan. Any entry added to the list skips
that directory and all the subdirectories below it.

¢ To add a directory, specify a directory in the Skip Directories field, then click Add.
¢ To edit an existing directory, select the directory, click Edit, edit the directory, then click OK.
¢ To delete an existing directory, select the directory, then click Remove.

7 In the Software Files panel, configure which types of files to scan for.
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Software Files

»

[ collect EXE filas
Additional Extensions:

File Categories:

[ system

[ ancillary Application
M ather

[“linclude directories with recognized products

Files and paths to include in collection Files and paths to exclude from collection

Software applications discovered in an inventory scan are identified by specific files associated
with the product. These identifications are kept in the ZENworks Knowledgebase. To identify
products that aren’t in the knowledgebase, you can search for files that are associated with an
unrecognized product and use the file information to create a new product identification called
a Local Software Product. This Local Software Product information can then be merged with the
knowledgebase so that these new products are recognized in subsequent scans. For more
information, see Chapter 6, “Creating Local Software Products,” on page 73. To configure the file
types, do the following:

¢ To search for files with an . exe extension, select the Collect. EXE Files option.

¢ To search for files with a different extension, specify the extension in the Additional
Extensions field. Separate each extension with a + sign, for example, com+d11.

¢ To scan for particular file types, select from the following;:

¢ System: Select this option to search for system files. This category is selected by
default.

¢ Ancillary Application: Select this option to search for files that are ancillary to, or
associated with, a product that is recognized by the ZENworks Knowledgebase. This
option is useful to create a comprehensive scan. This category is selected by default.

¢ Other: Select this option to search for all other files. This category is selected by
default.

¢ To include directories with products that are recognized by the ZENworks Knowledgebase,
select Include directories with recognized products. This is useful to create a comprehensive
scan.

¢ To limit the scope of the scan by including and excluding files and paths, configure which
files and paths to include or exclude from the collection by using Add and Remove to specify
which files and paths you want to include and exclude from the scan. You can edit the files
and paths in the list by selecting the file or path and clicking Edit. If you specify a file or
path in the Files and paths to include in collection field, the scan is limited to just that file or
path. If a file or path is specified in the Files and paths to exclude from collection field, all files
and paths are searched except the specified file or path. Paths specified in the Software
Applications panel are also skipped.

NOTE: If you are specifying a path, you must include a trailing backslash (\). For example,
if you want to include all . exe files in the dir directory, type C:\dir\.

8 In the Advanced panel, configure diagnostic settings.
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Advanced
These options are intended for advanced diagnostics, Use them only under the guidance of a Novell Technical Support representative.

[ piagnostic tode

Special Options:
Collector Priority: MNormal v

Logins before first scan: |0

Click Apply or OK.

2.1.2  Configuring a Scan for Devices in a Folder

o 01~ W N P

In ZENworks Control Center, click the Devices tab, then click the Managed tab.

Click Details next to the folder containing the devices you want to configure a scan for.
Click the Settings tab.

In the Settings panel, click Inventory.

In the Catalog list, click Inventory.

In the Inventory panel, click Override settings.

This overrides the Management Zone settings for these devices.

In the Scan Now panel, configure how to run an inventory scan.

For configuring an inventory scan, perform steps from Step 7 on page 15 through Step 9 on
page 15 listed in Section 2.1, “Configuring an Inventory Scan,” on page 11.

2.1.3  Configuring an Inventory Scan for a Device

~N o 0o~ WN P

In ZENworks Control Center, click Devices, then click the Managed tab.
Click the folder containing the device you want to configure a scan for.
Click the device.

Click the Settings tab.

In the Settings panel, click Inventory.

In the Catalog list, click Inventory.

In the Inventory panel, click Override settings.

This overrides the Management Zone and folder settings for this device.
In the Scan Now panel, configure how to run an inventory scan.

For configuring an inventory scan, perform steps from Step 7 on page 15 through Step 9 on
page 15 listed in Section 2.1, “Configuring an Inventory Scan,” on page 11.

Scanning Managed Devices
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2.2 Scheduling an Inventory Scan

This section shows you how to schedule an inventory scan. By default, the inventory schedule is
already configured.

You can define the scan schedule settings at three levels:

¢+ Management Zone: The settings are inherited by all device folders and devices. To schedule a
scan for the Management Zone, see Section 2.2.1, “Configuring an Inventory Scan Schedule for
the Management Zone,” on page 16.

¢ Device Folder: The settings are inherited by all devices contained within the folder or its
subfolders. Overrides the Management Zone settings. To schedule a scan for devices in a folder,
see Section 2.2.2, “Configuring an Inventory Scan Schedule for Devices in a Folder,” on page 24.

¢ Device: The settings apply only to the device for which they are configured. Overrides the
settings at the Management Zone level and device folder level. To schedule a scan for a device,
see Section 2.2.3, “Configuring an Inventory Scan Schedule for a Device,” on page 24.

2.2.1  Configuring an Inventory Scan Schedule for the Management Zone

1 In ZENworks Control Center, click Configuration, then in the Management Zone Settings panel,
click Inventory.

2 Click Inventory Schedule in the category list.
3 In the Schedule Type field, select the type of schedule you want to use.
No Schedule: No scan is scheduled. See “No Schedule” on page 16.
Date Specific: Scans run on specified dates. See “Date Specific” on page 16.

Recurring: Scans run on a recurring schedule. See “Recurring” on page 17.

No Schedule
1 Select No Schedule in the Schedule Type field.

Scan Schedule
Specify the schedule the device inventory scanner should run on:

Schedule Type:
‘Mo Schedule v

0K Apply Reset Cancel

2 Click Apply or OK.

No automatic scans are configured.

Date Specific

1 Select Date Specific in the Schedule Type field.
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Scan Schedule
Specify the schedule the device inventory scanner should run on:

Schedule Type:
:Date Specific v

Start Date(s):

[ Run event every year
[ Process immediately if device unable to execute on schedule

Select when schedule execution should start:
® start immediately at Start Time
O start at a random time between Start and End Times

Start Time: 1 % || 00 % |am v End Time: :
[use coordinated Universal Time [ Current UTC 9:55 P4

114 Apply Heset Cancel

2 Click the +icon to the right of the Start Date(s) field to open a calendar, then select a date. To
select more than one date, click the + icon again. Click the - icon to delete a selected date.

3 (Optional) Select Run event every year to run a scan annually on the dates you selected.

4 (Optional) For some reason, if the event does not run on the schedule you configured, to trigger
the event immediately, select Process immediately if device unable to execute on schedule.

5 Select whether you want the scan to start at a specified time or at a random time between a
specified start and end time.

6 Specify a start time, and if you selected Start at a random time between Start Time and End Time,
specify an end time.

7 (Optional) Select Use Coordinated Universal Time (UTC). Recommended, if the management zone
is across geographical locations.

8 Click Apply or OK.

Recurring

Select whether you want the scan to run when a device is refreshed, on certain days of the week,
monthly, or at a fixed interval.

To run a scan when a device is refreshed:

1 Select Recurring in the Schedule Type field.

Scanning Managed Devices 17
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Scan Schedule
Specify the schedule the dewvice inventory scanner should run on:

schedule Type:
[ Recurring

EV|

O When a device is refreshed
Delay execution after refresh: I:I Days l:l Hours l:l thinutes

O Days of the week

Sun Mon Tue Wed Thu Fri Sat

Start Time: | | :|
thore Options

@M‘.onthlyr

® Day of the manth:

O Last day of the month
Of | |

StartTime:|1 V|:|IJD Vlam V|

tore Options
O Fixed Interval
I:I tdonths l:l \eeks l:l Days l:l Hours l:l tinutes
start Date: IB,’ZS,’D? Start Time: | | :| | |

Wore Options

Reset | [ Ccancel

0K | [ Apply

2 Select When a device is refreshed.

Schedule Type:
| Fecurring

{ZIWhen a device is refreshed
[(belay execution after refresh: I:I Days l:l Hours I:I tinutes

]

3 (Optional) If you want the scan to be delayed for a set time after a refresh, select Delay execution

after refresh and specify the time in days, hours, and minutes.

4 Click Apply or OK.
To run a scan on certain days of the week:

1 Select Recurring in the Schedule Type field.

ZENworks 11 SP3 Asset Inventory Reference



Scan Schedule
Specify the schedule the dewvice inventory scanner should run on:

schedule Type:
[ Recurring

EV|

O When a device is refreshed
Delay execution after refresh: I:I Days l:l Hours l:l thinutes

O Days of the week

Sun Mon Tue Wed Thu Fri Sat

Start Time: | | :| | |
thore Options

@M‘.onthlyr

® Day of the manth:

O Last day of the month
Of | |

StartTime:|1 V|:|IJD Vlam V|

tore Options
O Fixed Interval
I:I tdonths l:l \eeks l:l Days l:l Hours l:l tinutes
start Date: IB,’ZS,’D? Start Time: | | :| | |

Wore Options

Reset | [ Ccancel

0K | [ Apply

2 Select Days of the week.

®Days of the week
S5un Mon Tue Wed Thu Fri

Ooooo6oo0oand

V|:|DD Vlam V|

Sat

Start Time: | 1

tore Options

3 Select the days on which you want the scan to run.
4 In the Start Time field, specify the time you want the scan to start.

5 Click More Options.
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@ Days of the week
Sun Mon Tue Wed Thu Fri Sat
OooOoooogad
Start Time: |1 % [:| 00 % | am *

Hide Options
[JProcess immediately if device unable to execute on schedule
[ use coordinated Universal Time [ Current UTC 9:56 Pi4 )
[Jstart at a random time between Start and End Times

End Time:

[Jrestrict schedule execution ta the following date range:

Start Date: [6/28/07
End Date: [§/29/07

6 (Optional) For some reason, if the event does not run on the schedule you configured, to trigger
the event immediately, select Process immediately if device unable to execute on schedule.

7 (Optional) Select Use Coordinated Universal Time (UTC). Recommended, if the management zone
is across geographical locations.

8 (Optional) If you want the scan to start randomly between a specified start and end time, select
Start at a random time between Start Time and End Time, then specify an end time.

9 (Optional) If you want to restrict the scan to a certain date range, select Restrict schedule execution
to the following date range, then specify the start and end dates.

10 Click Apply or OK.
To run a scan monthly:

1 Select Recurring in the Schedule Type field.
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Scan Schedule
Specify the schedule the dewvice inventory scanner should run on:

schedule Type:
[ Recurring

EV|

O When a device is refreshed

Delay execution after refresh: I:I Days l:l Hours l:l thinutes

O Days of the week

Sun Mon Tue Wed Thu Fri Sat

Start Time: |
thore Options

@M‘.onthlyr
® Day of the manth:

O Last day of the month
Ol |
StartTime:|1 V|:| oa Vl am V|
thare Qptions

O Fixed Interval

I:I tdonths l:l \eeks l:l Days l:l Hours l:l tinutes
start Date: IB,’ZS,’D? Start Time: | | :| |

Wore Options

|

Cancel

Reset

0K | [ Apply

2 Select Monthly.

{#I Monthly
& Day of the manth:

ClLast day of the month
O
Start Time: | 1 V| :| oo vl arn V|

More Options

|

3 Select either Day of the month and specify a number between 1 and 31, Last day of the month, or
select the configurable field where you can choose a combination of days of the month for a

recurring scan.
4 In the Start Time field, specify the time you want the scan to start.

5 Click More Options.
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@'N‘.onthlyr
® Day of the month: |1
O Last day of the maonth
o
Start Time: |1 % || 00 % |am v

Hide Options
[Jprocess immediately if dewice unable to execute on schedule
[Juse Coardinated Universal Tima [ Current UTC 9:56 Ph |
[start at a random time between Start and End Times

End Time:

[ restrict schedule execution ta the following date range:

start Date: [6/28/07
End Date: [6/28/07

6 (Optional) For some reason, if the event does not run on the schedule you configured, to trigger
the event immediately, select Process immediately if device unable to execute on schedule.

7 (Optional) Select Use Coordinated Universal Time (UTC). Recommended, if the management zone
is across geographical locations.

8 (Optional) If you want the scan to start randomly between a specified start and end time, select
Start at a random time between Start Time and End Time, then specify an end time.

9 (Optional) If you want to restrict the scan to a certain date range, select Restrict schedule execution
to the following date range, then specify the start and end dates.

10 Click Apply or OK.
To run a scan at a fixed interval:

1 Select Recurring in the Schedule Type field.
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Scan Schedule

Specify the schedule the dewvice inventory scanner should run on:

schedule Type:
‘Recurring

O When a device is refreshed

Delay execution after refresh:

O Days of the week
Sun Mon Tue Wed Thu Fri

sat
Start Time:

thore Options

@M‘.onthlyr
® Day of the manth: |1
O Last day of the month
O

Start Time: |1 |: 00 »|am v

tore Options

O Fixed Interval
tdonths \eeks Days

start Date: IB,’ZS,’D? Start Time:

Wore Options

Drays Haours

Hours

Minutes

Minutes

[1].9 Apply Reset Cancel

2 Select Fixed Interval.

{31 Fixed Interval

0 |Months | O |weeks |0 |Days |0 | Hours

0 | Minutes

StartDate:IE,’ZSfD? start Time: |1 % |2 00 % | am +

hore Options

3 Specify the number of months, weeks, days, hours, and minutes in their respective fields.

NOTE:

¢ If a Satellite with Collection role is configured in the Management Zone, ensure that the

scan interval is set such that the scan schedule is less frequent than the Collection Roll-Up

Schedule.

¢ Currently, When a device is refreshed Schedule Type is not effective for Inventory Scans.

4 Specify a start date by clicking the calendar icon and selecting a date.

5 In the Start Time field, specify the time you want the scan to start.

6 Click More Options.
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2.2.2

2.2.3

24

10

@ Fixed Interval
0 |sonths |0 |weeks |0 |Days |0 |Hours |0 | Minutes

Start Date:IB,’ZS,-’D? Start Time: |1 % |: 00 | am

Hide Options

[Jrrocess immediately if dewice unable to execute on schedule
[Juse Coordinated Universal Time
[JRestrict schedule execution ta the following date range:

End Date: IB 29/07 End Time: :
i [ Current UTC 9:56 Phi )

(Optional) For some reason, if the event does not run on the schedule you configured, to trigger
the event immediately, select Process immediately if device unable to execute on schedule.

(Optional) Select Use Coordinated Universal Time (UTC). Recommended, if the management zone
is across geographical locations.

(Optional) If you want to restrict the scan to a certain date range, select Restrict schedule execution
to the following date range, then specify an end date and end time.

Click Apply or OK.

Configuring an Inventory Scan Schedule for Devices in a Folder

1

In ZENworks Control Center, click Devices, then click the Managed tab.

2 Click Details next to the folder containing the devices you want to configure an inventory scan

o 01~ W

schedule for.

Click the Settings tab.

In the Settings panel, click Inventory.

In the Settings list, click Inventory Schedule.

In the Inventory Schedule panel, click Override settings.

This overrides the Management Zone settings for these devices.
In the Schedule Type field, configure the schedule you want to use.

For configuring the schedule type, perform steps from Step 3 on page 16 through Step 3 on
page 15 listed in Section 2.2.1, “Configuring an Inventory Scan Schedule for the Management
Zone,” on page 16.

Configuring an Inventory Scan Schedule for a Device

~N o 0o~ WN P

In ZENworks Control Center, click Devices, then click the Managed tab.

Click the folder containing the device you want to configure an inventory scan schedule for.
Click the device.

Click the Settings tab.

In the Settings panel, click Inventory.

In the Settings list, click Inventory Schedule.

In the Inventory Schedule panel, click Override settings.

This overrides the Management Zone and folder settings for this device.
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8 In the Schedule Type field, configure the schedule you want to use.

For configuring the schedule type, perform steps from Step 3 on page 16 through Step 3 on
page 15 listed in Section 2.2.1, “Configuring an Inventory Scan Schedule for the Management
Zone,” on page 16.

2.3 Running an Inventory Scan

You can run a scan four different ways:

¢ Using a device Quick Task
¢ Using a device task
¢ Using the ZENworks Icon menu (this runs a scan of the local machine only)

¢ Using a schedule
To run an inventory scan using a Quick Task:

1 In ZENworks Control Center, click Devices, then click the Managed tab.

2 Click the folder with the desired device(s) and select one or more devices that you want to
inventory.

3 Click Quick Tasks > Inventory Scan.

Devices » Servers

Servers
New v Edit + Delete Action ~ =
|:| Status Hame = Typg W System Last Contact
Refresh Device...
O T windows 2000 Servers Dyng Refresh Palicies. ..
Clear Cache. ..
O T windows Server 2003 Dyni [ RED
- Inventary Wizard...
¥ [ zendocia Serv |nstall Bundie. .. se-spl-x86 12111 PM
4| [1-3013 Lanch Bundis... show 26 v tems
Reboot Shutdown Devices. .
Launch Application..,
Run Script...
Launch Jawva Application...

A Quick Task Status dialog box appears, showing the progress of the scan.
To run an inventory scan using a device task:

1 In ZENworks Control Center, click Devices, then click the Managed tab.
2 Open the folder with the desired device and click the device.

3 In the device tasks panel, click Server Inventory Scan if it's a server; click Workstation Inventory
Scan if it’s a workstation.

To run an inventory scan using the ZENWorks Icon menu:

NOTE: This feature is only available if the User Can Initiate Scan option is selected on the Inventory
configuration page. For more information, see Section 2.1, “Configuring an Inventory Scan,” on
page 11.

1 Right-click the ZENworks Icon and select Show Properties.
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Refresh

Shaow Progress

Show Properties

Help

2 Click Inventory.

o=

Novell. ZENworks =
Refresh Page Hel

Status Scan Schedule
Agent Schedule Type: Monthly
Servers Day to Run: 1st of the maonth
Palicies Start time: 01:00:00 MT+0530
Bundles Randomly dispatch between start and end times: False
Eundles
Eundle Locks Scan Mow (click Refresh Page to refresh scan times.)
Inventory Next Scan : Maon Moy 01 01:00:00 IST 2010
Logging Last Scan Start :Fri Oct 01 01:00:00 |ST 2010
Linux Proxy Last Scan End: Fr? Qct 01 01:00:29 IST 2010
: Last Upload = Fri Oct 01 01:00:39 ST 2010
Discovery
Deployment
External Services Inventory Summary
Package Locks System : Intel(Ry Core(TH)2 CPU 6700 & 2.66CHz System
Operating System : Movell SUSE Linux Enterprise Server 10 (i586)
MAC address : 000c296cazefl
Serial Number : 564d8974ffef442b-f581cVdcclbcael
Asset Tag : Mo Asset Tag

View Inventory Details

3 Click Scan Now.
4 (Optional) Click Refresh Page to update scan times.

To run an inventory scan by using a schedule, see Section 2.2, “Scheduling an Inventory Scan,” on
page 16.

2.4 Adding Hardware Products from ZENworks Control Center

In ZENworks Control Center, you can manually add a hardware product for a device if the hardware
product has not been reported in the Inventory Report after the Inventory scan. You can add a
hardware product in ZENworks Control Center, to map it with specific devices for tracking and easy
usage. For example, mapping a specific printer to a specific device.

To manually add a hardware to a device:

Log in to ZENworks Control Center. Click Devices and then Workstations.
Select any of the workstations, then click the Inventory tab.

Click Detailed Hardware/Software Inventory.

Scroll down and click Add Hardware.

On the Add Hardware page, select the required hardware product from the hardware products
listed in the drop-down.

aa A W N PP

6 Fill in the required details for the selected hardware product, then click Submit.
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2.5

2.5.1

The hardware products added to the device are displayed in the Hardware section of the Inventory
report except Logical Drive and Network Driver. These are listed separately under the respective
sections in the Inventory report.

Only the hardware products that are added manually to the device from ZENworks Control Center
should have the delete and edit option on the Add Hardware page. To delete from the database the
hardware product that is added to the device from the server, click Delete. To edit the hardware
product that is added to the device from ZENworks Control Center, click Edit.

Viewing an Inventory Report for a Managed Device

A device’s inventory includes information on hardware, software, and demographic data, which is
gathered in an inventory scan. You can view this report through ZENworks Control Center or by
using the ZENworks Icon menu. To view the Detailed Hardware/Software Inventory report, enable
the View Detailed Inventory rights setting from the Management Zone > Device rights.

¢ Section 2.5.1, “Using ZENworks Control Center to View a Managed Device’s Inventory,” on
page 27

¢ Section 2.5.2, “Using the ZENworks Icon Menu to View a Managed Device’s Inventory,” on
page 28

¢ Section 2.5.3, “Cleaning Up Historical Data from the Inventory,” on page 29

Using ZENworks Control Center to View a Managed Device’s Inventory

1 In ZENworks Control Center, click Devices.

2 Click the Managed tab.

3 Click the folder containing the device you want to view the inventory for.
4 Click the desired device.

5 Click the Inventory tab.

The Summary panel shows basic inventory information.

Summary
Last Scan Date: June 29, 2007 4:57:19 PM
Host Name: ZENDOCTA
Dept: Marketing
Location: Site Building Floar Room
Provo H
Detailed Hardware/Software Inventory
Hardware:
Asset Tag: Mo Asset Tag
Serfal Number:
System: Pentium D 3200 System
Operating System: wicrosoft Windows Server 2003 5.2 1 3790
thac Address: 000C2934B3E5
Total Memory: 1.94 GE
Free Hard Disk Space: 34,3 GB
Total Hard Disk Space: 40,8 GB

6 Click Detailed Hardware/Software Inventory for a complete inventory report.

This report shows detailed information about the device, including demographic data,
hardware information, and software. From this page, you can click the various links to get more
detailed information about the device.
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Check the History tab, to view the changes made on the device. The software or hardware
creation dates are based on the scan file processed on the server. If you have set a weekly scan on
the device for a certain day of the week, the change history shows the changes made between
two successive scans, with the date the scan is run. Only hotfix components show the actual
install date for the particular device.

You can export the report to Excel, CSV, or PDF formats. You can also edit selected data. For
more information, see Section 2.6, “Editing a Managed Device’s Inventory Data,” on page 30.

2.5.2 Using the ZENworks Icon Menu to View a Managed Device’s Inventory

1 Right-click the ZENworks icon and select Show Properties.

Refresh

Show Progress

Show Properties

Help

Status
Agent
Servers

Policies

Eundles
Bundles
Bundle Locks

Inventory
Logging

Linux Proxy
Discovery
Deployment

External Services

Package Locks

Novell. ZENworks

Scan Schedule

Schedule Type: Monthly

Day to Run: 1st of the month
Start time: 01:00:00 MT+0530
Randomly dispatch between start and end times: False

Scan Mow (click Refresh Page to refresh scan times.)

Next Scan :

Last Scan Start :
Last Scan End:
Last Upload :

Inventory Summary

System : Intel(Ry Core(TH)2 CPU G700 & 2.66CHz System
Operating System : Movell SUSE Linux Enterprise Server 10 {(i586)
MAC address : 000c296cazefl

Serial Number : S64d8874ffef442b-fS8lcydeclbcazefl

Asset Tag : Mo Asset Tag

View Inventory Details

{Qda .PH ve Agent. l e

Refresh Page Hel

Man Moy 01 01:00:00 IST 2010
Fri Qct 01 01:00:00 15T 2010
Fri Oct 01 01:00:28 IST 2010
Fri Oct 01 01:00:38 15T 2010
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3 Click View Inventory Details.

Workstation Detail Report KB Version: 3.06.4.0000.016

Miachine Mame Login IPaddress LaM Address

ZEWDOC1A SYSTEM 137.65.167.71 00029 34B385

Serial Number Aee=i Tz Tatal Memary (ME) Disk Space (ME] Free Disk Space (ME)

Mo fszet Tag 1984 40797 34299

Hardware

Mianufacturer Froduct #odel

Phioeniz ROM B0 Release Date: 120305

L5l Logic 5201030 PCI-X SCE| Contraller

Intel Corparation IDE Contraller 23T1AB/ER PIIX4

Sony OO -ROM DOUME1S Orive Letter

Intel Pentium O Speed: 2. 200000e+03 MHz | Ganuinzintel
ihware, hware Virtual 51.0 Drive Letters: , Space:85871¥2320
ihware, idhware Virtual 51.0 Drive Letters: , Space: 32210196480

Diskette Drive

101102 keyboard

AD PCNET Family Ethernet ddapter Lan Add ress:000C2934B365
Logitech PS/2 Mouse
Hhemary Module Size: 1024, Speed: 0
#hemary Module Size:51Z, Speed: 0
Hhemary Module Size:256, Speed: 0
Hhemory Moclule Size 208, Speed: 0
Color Monitor
Mricrasoft Windows Seruer 2003 5.2

Farallel Forts

Serial Ports

2.5.3 Cleaning Up Historical Data from the Inventory

1 Run the following procedure on the database:
Sybase: call zcm purgehistory (n, daystokeep)
Oracle: call zcm purgehistory (n, daystokeep)
SQL Server: exec zcm purgehistory n, daystokeep

2 Replace n with a number to minimize transaction log growth and daystokeep with the number
of days of history to be retained.

The value n is used to set a number for the records to be deleted at a time. Deleting all the
records at a time might load the database with transaction logs that could affect other database
operations in case they are using related tables.

If we set a value n=1000, this implies that we consider 1000 records need to be deleted for a given
interval, say one year. If there is any more data present that can be deleted, set a value for n again
to delete the next set of records. This can be repeated until all the records for the year are deleted,
to match the number of days criteria.

For example: if you want to retain one year of history, run call zcm_purgehistory (1000,
365).

Running this script helps you delete the following outdated information:

¢ Component and product data that have been marked as deleted
¢ Workstation change history

¢ Component change history

*

Software usage history

*

Cascade objects that reference component and product rows that were deleted
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NOTE: Using the Purge Inventory History option (under Inventory Settings) that is available in
ZENworks 11SP3, you can now clean up historical data from the Inventory, without having to run the
above mentioned script.

2.6  Editing a Managed Device’s Inventory Data

To edit the Detailed Hardware/Software Inventory report, you should enable the Modify setting on
the View Detailed Inventory rights page from the Management Zone > Device rights.

1 Open the Detailed Hardware/Software Inventory report as shown in Section 2.5, “Viewing an
Inventory Report for a Managed Device,” on page 27.

2 Click Edit.

Edit Workstation
ZENDOCTA

User

First Name E-mail

Middle Name Phone
Last Hame Second

Phone

Fax
Reference
Inventory Type Serial

Humber

Asset

Tag
Workstation
Site Provo Leased Mo+
Department Iarketing Lease

Expiration §/27/07

Cost Center 138 —_
Building H Lease
Ene I(Doml act

Room

Phone

Submit Cancel

3 Add or edit information on the Edit Workstation page.
User: Basic information about the user, including name, phone, and so on.
Reference: Inventory type, serial number, and asset tag. These values cannot be changed.

Workstation: Basic information about the workstation, including site, department, and so on.
Click the icon on the right to create a list of responses. Click the calendar icon next to the Lease
Expiration Date field to choose a date.

4 Click Submit.
The data is added to the inventory report.
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3.1

Scanning Inventory Only Devices

An inventory only scan allows you to scan devices in the zone that don’t have the ZENworks
Adaptive Agent installed but do have the Inventory Only Module installed. For information on
installing the Inventory Only Module, see the ZENworks 11 SP3 Discovery, Deployment, and Retirement
Reference.

The following sections provide information on inventory only scans:

¢ Section 3.1, “Configuring an Inventory Only Scan,” on page 31

*

Section 3.2, “Scheduling an Inventory Only Scan,” on page 34

*

Section 3.3, “Viewing an Inventory Report for an Inventory Only Device,” on page 38

*

Section 3.4, “Editing the Demographic Data of an Inventory Only Device,” on page 39

*

Section 3.5, “Enabling Reconciliation,” on page 40

*

Section 3.6, “Using the Portable Collector,” on page 41

Configuring an Inventory Only Scan

An inventory only scan allows you to collect data from devices in the Management Zone that only
have the Inventory Only Module installed. By default, the inventory settings are preconfigured.

To configure an inventory only scan:

1 Click Configuration, then in the Management Zone Settings panel, click Inventory.
2 Click Inventory Only in the category list.

3 In the Server Refresh Interval panel, set the interval time in days, hours, and minutes.

Server Refresh Interval E
Server refresh interval should be set so that refreshes occur maore frequently than scans.

0 |pays |0 |Hours |15 | minutes

The server handles requests from devices that have the Inventory Only Module installed,
providing files for the settings, scan schedule, and so on. The interval setting determines how
often the server evaluates the next scan schedule and when to obtain other settings. The server
needs to poll the database at frequent intervals to pass on any changes that affect the devices.

The refresh interval should be set so that refreshes occur more frequently than scans. The default
is 15 minutes.

NOTE: Ensure that the time interval of the Collection Server sending over data to the Primary
server is lesser than the time interval of the managed devices sending over data to the Collection
Server. For example, if Managed device M1 sends data to Collection Server every 12 minutes,
configure the Collection Server to send data to the Primary server every 8 minutes.

4 In the Device Refresh Interval panel, set the interval time in days, hours, and minutes.
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Device Refresh Interval P
Device refresh interval should be set so that refreshes occur rore frequently than scans and less frequently than server refreshes,

0 |Days |12 |Hours |0 | minutes

The Device Refresh Interval determines when the device checks the server for a change in
settings, the schedule for the next scan, the ZENworks Knowledgebase for inventory, and new
agent executables.

The refresh interval should be set so that refreshes occur more frequently than scans and less
frequently than server refreshes. The default is 12 hours.

5 In the Scan panel, configure how you want to run the scan.

»

Scan

Collect Software Applications [ collect bemographic Data
O callect software File Information O run DMTF Translator O callect st Infarmatian

Collect Software Applications: Select this option if you want to scan for software applications
installed on the device. This setting is selected by default.

Collect Software File Information: Select this option if you want to scan for software file
information that can be used to identify software products that are not recognized by the
ZENworks Knowledgebase. If you plan to create Local Software Products and add them to the
knowledgebase, this option must be selected. For more information, see Chapter 6, “Creating
Local Software Products,” on page 73.

Collect Demographic Data: Select this option to gather demographic data from an inventoried-
only device. This data is gathered from a file on the local machine. For more information, see
Section 4.6, “Scanning Demographic Data on an Inventory Only Device,” on page 60.

Run DMTF Translator: Select this option if you want to run the DMTF (Desktop Management
Task Force) Translator. The DMTF translator converts the inventory data to formats that can be
used by other tools and puts it on the local machine.

Collect MSI Information: Select this option if you want to scan for information about the
installed Microsoft Installer (MSI) files that are used for installation, storage, and removal of
programs on a device.

6 In the Software Applications panel, configure which directories to skip.
Software Applications

Skip Directories:
Add

- Edit

ChRecycled Remove
ChARecycler

CASystem Yolume Infarmation

ChAwindowsInstaller

Chwindows\FegisteredPackages

Chvindowsh ServicePackFileshiigh

CAWindows\$MT ServicePackUninstall$ v

Skipping directories is useful in limiting the scope of the scan. The directories in the list are
skipped.

¢ To add a directory, specify a directory in the Skip Directories field, then click Add.
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¢ To edit an existing directory, select the directory, click Edit, edit the directory, then click OK.
¢ To delete an existing directory, select the directory and click Remove.

7 In the Software Files panel, configure which types of files to scan for.

Software Files ES

[ collect EXE filas
Additional Extensions:

File Categories:

[ system

[ ancillary Application
M ather

[“linclude directories with recognized products

Files and paths to include in collection Files and paths to exclude from collection

Software applications discovered in an inventory scan are identified by specific files associated
with the product. These identifications are kept in the ZENworks Knowledgebase. To identify
products that aren’t in the knowledgebase, you can search for files that are associated with an
unrecognized product and use the file information to create a new product identification called
a Local Software Product. This Local Software Product information can then be merged with the
knowledgebase so that these new products are recognized in subsequent scans. For more
information, see Chapter 6, “Creating Local Software Products,” on page 73. To configure the file
types, do the following;:

¢ To search for files with an . exe extension, select the Collect. EXE Files option.

¢ To search for files with a different extension, specify the extension in the Additional
Extensions field. Separate each extension with a + sign, for example, com+d11.

¢ To scan for particular file types, select from the following;:

¢ System: Select this option to search for system files. This category is selected by
default.

¢ Ancillary Application: Select this option to search for files that are ancillary to, or
associated with, a product that is recognized by the ZENworks Knowledgebase. This
option is useful to create a comprehensive scan. This category is selected by default.

¢ Other: Select this option to search for all other files. This category is selected by
default.

¢ To include directories with products that are recognized by the ZENworks Knowledgebase,
select Include directories with recognized products. This is useful to create a comprehensive
scan.

¢ To limit the scope of the scan by including and excluding files and paths, configure which
files and paths to include or exclude from the collection by using Add and Remove to specify
which files and paths you want to include and exclude from the scan. You can edit the files
and paths in the list by selecting the file or path and clicking Edit. If you specify a file or
path in the Files and paths to include in collection field, the scan is limited to just that file or
path. If a file or path is specified in the Files and paths to exclude from collection field, all files
and paths are searched except the specified file or path. Paths specified in the Software
Applications panel are also skipped.
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NOTE: If you are specifying a path, you must include a trailing backslash (\). For example,
if you want to include all . exe files in the dir directory, type C:\dir\.

8 In the Advanced panel, configure diagnostic settings.

Advanced
These options are intended for advanced diagnostics, Use thern only under the guidance of a Novell Technical support representative,

[ piagnastic Made

Special Options:

Collector Priority: MNaormal v

WARNING: These options are intended for advanced diagnostics. Use them only under the
guidance of a Novell Support representative.

9 In the Collection Servers panel, use the Move Up and Move Down buttons to arrange the
collection servers.

This arrangement determines the order in which the collection servers receive the inventory
data.

10 Click Apply or OK.

3.2 Scheduling an Inventory Only Scan

This section shows you how to schedule an inventory scan for an inventory only device. By default,
the inventory schedule is already configured.

Unlike scans for managed devices, you can only define an inventory only scan for the entire
Management Zone. In addition, you can run a scan only by using a schedule.

3.2.1 To Configure an Inventory Only Scan Schedule

1 In ZENworks Control Center, click Configuration, then in the Management Zone Settings panel,
click Inventory.

2 Click Inventory Only Schedule in the category list.
3 In the Schedule Type field, select what type of schedule you want to use.
No Schedule: No scan is scheduled. See “No Schedule” on page 34.
Date Specific: Scans run on specified dates. See “Date Specific” on page 35.

Recurring: Scans run on a recurring schedule. See “Recurring” on page 35.

No Schedule

1 Select No Schedule in the Schedule Type field.
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Scan Schedule
Specify the schedule the device inventory scanner should run on:

Schedule Type:
‘Mo Schedule v

118 Apply Reset Cancel

2 Click Apply or OK.

No automatic scans are configured.

Date Specific

1 Select Date Specific in the Schedule Type field.

Schedule Type:

Date Specific v
Start Date(s):
Start Time:| 1 % | 00 ¥ |am

2 Click the +icon to the right of the Start Date(s) field to open a calendar, then select a date. To

select more than one date, click the + icon again. Click the - icon to delete a selected date.

3 Specify a start time.
4 Click Apply or OK.

Recurring

Select whether you want the scan to run when a device is refreshed, on certain days of the week,

monthly, or at a fixed interval.
To run a scan on certain days of the week:

1 Select Recurring in the Schedule Type field.
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Schedule Type:
: Frecurring v

O Days of the week

Sun Mon Tue Wed Thu Fri Sat

Start Time:

@ Monthly
@ Day of the month: |1
O Last day of the month
O

Start Time: |1 % || 00 ¥ |am +

O Fixed Interval
tonths Waeks Danys Hours Minutes

Start Date: I?,-"Z,-’U? Start Time:

2 Select Days of the week.

@Days of the week
Sun Mon Tue Wed Thu Fri 3at

Ooo0oo0oo0ooOoaogano

Start Time: |1 % |: 00 % | am »

3 Select the days on which you want the scan to run.
4 In the Start Time field, specify the time you want the scan to start.
5 Click Apply or OK.

To run a scan monthly:

1 Select Recurring in the Schedule Type field.
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Schedule Type:
: Frecurring v

O Days of the week

Sun Mon Tue Wed Thu Fri Sat

Start Time:

@ Monthly
@ Day of the month: |1
O Last day of the month
O

Start Time: |1 % || 00 ¥ |am +

O Fixed Interval
tonths Waeks Danys

Start Date: I?,-"Z,-’U? Start Time:

Minutes

2 Select Monthly.

@ Monthly
@ pay of the month: |1
O Last day of the month
O

Start Time: |1 % [:| 00 v |am

3 Select either Day of the month and specify a number between 1 and 31, Last day of the month, or
select the configurable field where you can choose a combination of days of the month for a

recurring scan.

4 In the Start Time field, specify the time you want the scan to start.

5 Click Apply or OK.

To run a scan at a fixed interval:

1 Select Recurring in the Schedule Type field.
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Schedule Type:
: Frecurring v

O Days of the week

Sun Mon Tue Wed Thu Fri Sat

Start Time:

@ Monthly
@ Day of the month: |1
O Last day of the month
O

Start Time: |1 % || 00 ¥ |am +

O Fixed Interval
tonths Waeks Danys Hours

Start Date: I?,-"Z,-’U? Start Time:

Minutes

Select Fixed Interval.

{#I Fixed Interval
0 | tonths |0 |%Weeks |0 |Days |0 |Hours

StartDate:I?,’ZfD? Start Time: |1 % |

0 | Minutes

00 v |am

Specify the number of months, weeks, days, hours, and minutes in their respective fields.

Specify a start date by clicking the calendar icon and selecting a date.

In the Start Time field, specify the time you want the scan to start.

Click Apply or OK.

NOTE: Ensure that the Collection Roll-Up Schedule is more frequent than the scan interval if the
Satellite with Collection role is configured in the Management Zone.

Viewing an Inventory Report for an Inventory Only Device

A device’s inventory includes information on hardware, software, and demographic data, which is
gathered in an inventory scan. To view the Detailed Hardware/Software Inventory report, enable the
View Detailed Inventory rights setting from the Management Zone > Inventoried Device rights.

To view an inventoried-only device’s inventory:

1 In ZENworks Control Center, click Deuvices.

2

Click the Inventoried tab.

3 Click the folder containing the device you want to view the inventory of.

4

Click the desired device.

The Inventory panel shows basic inventory information.
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Inventored Devices > Workstations > ZENDOCWES 1

Inventory 2
Last Scan Date: July 2, 2007 10:32:16 At
Host Name: ZENDOCIAKST
Dept:
Location:
Detailed Har dware/Software Inventory
Hardware:
Asset Tag: No Asset Tag
Serial Number:
Systemn: Pentium D 3200 System
Operating System: Microsoft Windows 3P Professional 5.1 2 2600
#ac Address: 000C292D1B1E
Total Memory: 256 B
Free Hard Disk Space: 4.47 GB
Total Hard Disk Space: 8.59 GB

5 Click Detailed Hardware/Software Inventory for a complete inventory report.

This report shows detailed information about the device, including demographic data,
hardware information, and software. From this page, you can click the various links to get more
detailed information about the device.

Check the History tab, to view the changes made on the device. The software or hardware
creation dates are based on the scan file processed on the server. If you have set a weekly scan on
the device for a certain day of the week, the change history shows the changes made between
two successive scans, with the date the scan is run. Only hotifx components show the actual
install date for the particular device.

You can export the report to Excel, CSV, or PDF formats. You can also edit demographic data.
For more information, see Section 2.6, “Editing a Managed Device’s Inventory Data,” on page 30.

You can clean up historical inventory data from the database, see Section 2.5.3, “Cleaning Up
Historical Data from the Inventory,” on page 29.

3.4 Editing the Demographic Data of an Inventory Only Device

To edit the Detailed Hardware/Software Inventory report, you should enable the Modify setting on
the View Detailed Inventory rights page from the Management Zone > Inventoried Device rights.

1 Open the Detailed Hardware/Software Inventory report as shown in Section 2.5, “Viewing an
Inventory Report for a Managed Device,” on page 27.

2 Click Edit.
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Edit Workstation
ZENDOCTA

User
First Name E-mail
Middle Name Phone

Last Hame Second

Phone

Reference

Inventory Type Serial
Humber

Asset
Tag

Workstation

Site Pravo Leased Mo v
Department Market Lease

epartmen ereetng Expiration [B27/17
Cost Center 135 Date

Building H Lease

b I([;)mla(t

Room

Phone

Submit Cancel

3 Add or edit information on the Edit Workstation page.
User: Basic information about the user, including name, phone, and so on.
Reference: Inventory type, serial number, and asset tag. These values cannot be changed.

Workstation: Basic information about the workstation, including site, department, and so on.
Click the icon on the right to create a list of responses. Click the calendar icon next to the Lease
Expiration Date field to choose a date.

4 Click Submit.
The data is added to the inventory report.

3.5 Enabling Reconciliation

Inventory Only Reconciliation allows you to control whether and how new workstations are
reconciled to avoid the possibility of duplicates in the database. When a scan is made of a
workstation that is new to the Management Zone, it is assigned an identifier. If the identifier is lost,
such as by a disk crash, it is assigned a new identifier during the next scan. Reconciliation allows you
to check whether the workstation is already in the database. If it is, the identifier in the database is
changed to match the new identifier.

You can use any or all of the following device attributes to identify a workstation for possible
reconciliation:

+ Serial Number
+ MAC Address

¢ Machine Name
To enable inventory only reconciliation:

1 In ZENworks Control Center, click the Configuration tab.
2 In the Management Zone Settings panel, click Inventory.

3 In the Category list, click Inventory Only Reconciliation.
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3.6

3.6.1

Inventory Only Reconciliation

Configure inventory only reconciliation settings,

Auto-Reconcile Settings

Indicate which device attributes will be used in reconciliation

[¥]serial Mumber [¥] bac Address [ #tachine Name

Enable Differentiation

0K Cancel

4 In the Auto-Reconcile Settings panel, select which device attributes you want to use for
reconciliation.

¢ Serial Number

¢ Mac Address

¢ Machine Name
5 Select Enable Differentiation to differentiate between workstations with the same identifier.
6 Click Apply or OK.

Using the Portable Collector

The Portable Collector is a standalone application that is used to inventory devices that rarely
connect to the server or devices that do not have the ZENworks Adaptive Agent installed. This data
can then be imported into the Inventoried device list. When the data is imported, you can view and
edit it just as you would an inventoried device. The Portable Collector can be run on Windows and
OSX devices. The procedure is as follows:

1. Create the Portable Collector.

2. Run the Portable Collector on a device.

3. Copy the inventory data to a portable media.

4.

Upload the inventory data into ZENworks Control Center.
For more information, see the following;:

¢ Section 3.6.1, “Creating the Portable Collector for a Windows Device,” on page 41
¢ Section 3.6.2, “Running the Portable Collector on a Windows Device,” on page 42
¢ Section 3.6.3, “Running the Portable Collector on an OSX Device,” on page 42

¢ Section 3.6.4, “Importing Data Gathered with the Portable Collector,” on page 42

Creating the Portable Collector for a Windows Device

1 Configure an Inventory Only scan.

The Inventory Only scan settings are used when you create the Portable Collector. If you want
the Portable Collector to scan for software files, for example, that option must be selected on the
Inventory Only configuration page. For information on configuring an Inventory Only scan, see
Section 3.1, “Configuring an Inventory Only Scan,” on page 31.
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2
3
4
5

Click Devices.
In the Device Tasks list, click Create Portable Client.
Save the file to disk.

Uncompress the file and continue with Section 3.6.2, “Running the Portable Collector on a
Windows Device,” on page 42.

3.6.2 Running the Portable Collector on a Windows Device

1

Create the Portable Collector as shown in Section 3.6.1, “Creating the Portable Collector for a
Windows Device,” on page 41.

2 Copy the Portable Collector files to a removable media, such as a CD or flash drive.

3 Take the Portable Collector to the device you want to inventory, then run collect.bat.

To see the available switches, type /? on the command line.

Copy the inventory data files onto a removable media, then take it to a device connected to
ZENworks Control Center.

Continue with Section 3.6.4, “Importing Data Gathered with the Portable Collector,” on page 42.

3.6.3 Running the Portable Collector on an OSX Device

1

o 01~ W N

~

10

11

12

Navigate to https://ZENworks_Server_ID/zenworks-setup/ (where ZENworks_Server_ID is the
DNS name or IP address of a Primary Server).

Click Inventory Tools.

Click osxportable.dmg to download it to the desktop.
Uncompress osxportable.dmg.

Create a temporary folder to run the portable scan from.

Copy the contents of osxportable, which is found in /Volumes/osxportable, to the temporary
folder.

Close (eject) the osxportable image.

Open a terminal window.

You must be a user with administrative privileges.

Run sudo ./zenumia-portable /full/path/to/output/directory.

The WIF file (<xxx>.xml) will be written there. This file contains the device’s inventory data. It
will be convenient for the output directory to be accessible by a Windows device. Or you can
copy the file and put it on a device connected to the ZENworks Control Center.

When the scan finishes, remove the temporary directory you created in Step 5 and the file
osxportable.dmg that you downloaded in Step 3.

Import the file into ZENworks Control Center as shown in Section 3.6.4, “Importing Data
Gathered with the Portable Collector,” on page 42.

Remove the inventory data file.

3.6.4 Importing Data Gathered with the Portable Collector

1
2

In ZENworks Control Center, click Devices.

In the Device Tasks list, click Import Inventory.
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3 In the File Path for inventory scan file field, specify the file name of the inventoried data, or click
Browse to search.

4 Click OK.

The inventoried device appears in the device lists in Devices > Inventoried, where you can click
the device name and see the inventory data.
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4.1

Scanning Demographic Data

Inventory scans include demographic data that is gathered from workstation users through the use

of the Collection Data Form. The Collection Data Form can be sent to a workstation user’s computer
with a prompt to fill out the data fields on the form. This data is then added to the inventory report

for that workstation. This section includes the following topics:

¢ Section 4.1, “Configuring the Collection Data Form,” on page 45
¢ Section 4.2, “Deploying the Collection Data Form,” on page 49

*

Section 4.3, “Configuring the Collection Data Form Launch Schedule,” on page 50

*

Section 4.4, “Launching the Collection Data Form Using a Quick Task,” on page 58

*

Section 4.5, “Deploying the Data Collection Form Using a Device Task,” on page 59

*

Section 4.6, “Scanning Demographic Data on an Inventory Only Device,” on page 60

Configuring the Collection Data Form

When you configure the Collection Data Form, you are selecting what information you want to
gather from the workstation user. The Collection Data Form is not configured by default. It must be
configured before it can be deployed.

NOTE: Collection Data Form is not supported on Mac OSX managed devices.

You can define the Collection Data Form at three levels:

¢+ Management Zone: The settings are inherited by all device folders and devices. To configure the
Collection Data Form for the Management Zone, see Section 4.1.1, “Configuring the Collection
Data Form for the Management Zone,” on page 46.

¢ Device Folder: The settings are inherited by all devices in the folder. Overrides the settings at
the Management Zone level. To configure the Collection Data Form for a folder, see Section 4.1.2,
“Configuring the Collection Data Form for Devices in a Folder,” on page 47.

¢ Device: The settings apply only to the device for which they are configured. Overrides the
settings at the folder and Management Zone levels. To configure the Collection Data Form at the
device level, see Section 4.1.3, “Configuring the Collection Data Form for a Device,” on page 48.

NOTE: If you are configuring the Collection Data Form settings on a device, you need to click
Opwerride Settings before you can change the system settings.

After it is configured and deployed, the Collection Data Form appears on the desktop of a managed
device and prompts the workstation user to respond to a list of predefined questions.
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For more information, see the following topics:

¢ Section 4.1.1, “Configuring the Collection Data Form for the Management Zone,” on page 46
¢ Section 4.1.2, “Configuring the Collection Data Form for Devices in a Folder,” on page 47

¢ Section 4.1.3, “Configuring the Collection Data Form for a Device,” on page 48

Configuring the Collection Data Form for the Management Zone

1 In ZENworks Control Center, click Configuration.
2 In the Management Zone Settings panel, click Inventory.

3 In the Category list, click Collection Data Form.

Collection Data Form A

Introduction Text
[Cshow In ZENwarks Ican wenu

[CIshow Cancel button on form

[invisible mode for autofill only

Label Type Display Editable Required Autofill Default Choice List Edit Mask Instructions

First Name character [] O O MO v
Middle Name Character [ O [} Mo v
Last Name Character [ O ] Mo v
Ebdail Character [ O O Mo -
phane character [] O F NO -
second Phone character [] O [} MO v
Fax Character [] O O Mo v
Site Character [J 0O ] Mo ~ | [Edit] L2
Department Character [ O O Mo w | (Edit] v
Cost Center Character [ O O MO ~ | [Edit] ~
Building Character [ O O Mo ~ | [Edit] ~

Specify any explanatory text for the workstation user in the Introductory Text field.

5 (Optional) If you want the Collection Data Form to be available to the workstation user to run at

anytime, select Show in ZENworks Icon Menu.

This allows the workstation user to open the form by using the ZENworks Icon, and edit it as
desired.

(Optional) Select Show Cancel button on form if you want to allow the workstation user to opt out
of the process.

(Optional) Select Invisible mode for autofill only to populate the form with the autofill data. The
form is hidden from the workstation user.

Select the data you want to gather, and configure how the workstation user can respond:
Label: Displays the name of the data you're collecting, such as First Name.

Data Type: Specifies the data type: character, integer, decimal, or date.
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Display: Displays the specified field on the Collection Data Form that is sent to the workstation
user.

Editable: Enables the user to enter or edit a response in the specified field rather than being
forced to accept the default value.

Required: Makes the response required. If a field is required, workstation users cannot submit
the form until they enter the required data.

Autofill: Shows whether Autofill is on or off. Click No (or Yes, as appropriate) to open the
Autofill dialog box, where you can specify a registry key or environment variable to populate
the Collection Data Form field with the data that the registry key or variable points to, such as
HKLM\SYSTEM\CurrentControlSet\Services\Eventlog\ComputerName for this registry key,
or WinDir for this environment variable. You can also use a registry key with a space in it, such
as HKEY CURRENT USER\Control Panel\Screen Saver.Stars\Density.

Default: Specify any value you want to use as a default value.

Choice List: If there is more than one possible response, click Edit and specify the available
responses. You can also choose to allow the workstation user to create entries by selecting Allow
user created entries.

Edit Mask: Allows you to restrict how a user enters a response by selecting a format from the list
in the Edit Mask field. The choices are phone, time, and currency.

Instructions: Add any instructions for the workstation user.

9 Click Apply or OK, or click Reset to revert to previous settings.

NOTE: You can also create custom fields, called administrator-defined fields, to gather additional
data. For more information, see Chapter 7, “Using Administrator-Defined Fields,” on page 85.

4.1.2 Configuring the Collection Data Form for Devices in a Folder

1 In ZENworks Control Center, click Deuvices.

2 In the Devices panel, click Details next to the folder whose devices you want to configure.
3 Click the Settings tab.

4 In the Settings panel, click Inventory.

5 In the Category panel, click Collection Data Form.
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Collection Data Form

Intraduction Text
[dshow In ZENworks Icon Menu

[CIshow Cancel button on form

[invisible mode for autafill onky

Label Type Display Editable Required Autofill Default Choice List Edit Mask Instructions
First Mame Character [ O ] Mo v
widdle Name Character [ O O Mo -
Last Name character [] O F NO -
Edaail character [] O [} MO v
Phone Character [] O O Mo v
second Phane Character [J O ] Mo -
Fax Character [ O (| Mo -
Site Character  [] O O Mo ~ | [Edit] ~
Department character [ O O Mo ~ | [Edit] v
Cost Center Character [ O O Mo ~ | [Edit] v
Building Character [J O ] Mo + | [Edit] v

6 Click Override settings.
This overrides the Management Zone settings for these devices.
7 In the Introductory Text field, specify information to configure the Collection Data Form.

For configuring the Collection Data Form, perform steps from Step 4 on page 46 through Step 9
on page 47 listed in Section 4.1.1, “Configuring the Collection Data Form for the Management
Zone,” on page 46.

4.1.3  Configuring the Collection Data Form for a Device

In ZENworks Control Center, click Devices.

Click the Managed tab.

Click the folder that contains the device you want to configure.
Click the device.

Click the Settings tab.

In the Settings panel, click Inventory.

~N o 0o~ WN P

In the Catalog panel, click Collection Data Form.
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Collection Data Form

Intraduction Text
[dshow In ZENworks Icon Menu

[CIshow Cancel button on form

[invisible mode for autafill onky

Label Type Display Editable Required Autofill Default Choice List Edit Mask Instructions
First Mame Character [ O ] Mo v

widdle Name Character [ O O Mo -
Last Name character [] O F NO -
Edaail character [] O [} MO v
Phone Character [] O O Mo v
second Phane Character [J O ] Mo -
Fax Character [ O (| Mo -
Site Character  [] O O Mo ~ | [Edit] ~
Department character [ O O Mo ~ | [Edit] v
Cost Center Character [ O O Mo ~ | [Edit] v
Building Character [J O ] Mo + | [Edit] v

8 Click Ouerride settings.
This overrides the Management Zone and folder settings for this device.
9 In the Introductory Text field, specify information to configure the Collection Data Form.

For configuring the Collection Data Form, perform steps from Step 4 on page 46 through Step 9
on page 47 listed in Section 4.1.1, “Configuring the Collection Data Form for the Management
Zone,” on page 46.

4.2 Deploying the Collection Data Form

There are four ways you can deploy the Collection Data Form to a workstation:

¢ Collection Data Form Schedule: Using the Collection Data Form schedule deploys the form to
all the workstations in the Management Zone. For more information, see Section 4.3,
“Configuring the Collection Data Form Launch Schedule,” on page 50.

¢ Device Quick Task: Using a device Quick Task deploys the Data Collection Form to one or more
workstation in a folder. For more information, see Section 4.4, “Launching the Collection Data
Form Using a Quick Task,” on page 58.

¢ Device Task: Using a device task deploys the Data Collection Form to a specified workstation.
For more information, see Section 4.5, “Deploying the Data Collection Form Using a Device
Task,” on page 59.

¢ Scheduled as part of an inventory scan: Using the inventory scan schedule deploys the
Collection Data Form to all the workstations in the Management Zone. For more information,
see Section 2.1, “Configuring an Inventory Scan,” on page 11.
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4.3 Configuring the Collection Data Form Launch Schedule

NOTE: If you selected Show in ZEN Icon Menu on the Collection Data Form configuration page, the
Collection Data Form is always available to the workstation user to run at anytime. For more
information, see Section 4.1, “Configuring the Collection Data Form,” on page 45.

You can define the schedule at three levels:

¢+ Management Zone: The settings are inherited by all device folders and devices. To schedule the
deployment of the Data Collection Form for the Management Zone, see Section 4.3.1,
“Configuring the Collection Data Form Launch Schedule for the Management Zone,” on
page 50.

¢ Device Folder: The settings are inherited by all devices in the folder. Overrides the settings at
the Management Zone level. To schedule the deployment of the Data Collection Form for a
device folder, see Section 4.3.2, “Scheduling the Deployment of the Collection Data Form for
Devices in a Folder,” on page 57.

¢ Device: The settings apply only to the device for which they are configured. Overrides the
settings at the Management Zone level. To schedule the deployment of the Data Collection Form
for a device, see Section 4.3.3, “Scheduling the Deployment of the Collection Data Form for a
Device,” on page 58.

4.3.1 Configuring the Collection Data Form Launch Schedule for the
Management Zone

1 In ZENworks Control Center, click Configuration.
2 In the Management Zone Settings panel, click Inventory > Collection Data Form Schedule.

3 In the Schedule Type field, select the type of schedule you want to use to send out the Collection
Data Form. You can select from the following options:

No Schedule: No deployment is scheduled. See “No Schedule” on page 50.

Date Specific: The Collection Data Form is deployed on specified dates. See “Date Specific” on
page 51.

Recurring: The Collection Data Form is deployed on a recurring schedule. See “Recurring” on
page 51.

Event: Deployment is triggered by an event. See “Event” on page 57.

No Schedule

1 Select No Schedule in the Schedule Type field.

Collection Data Form Schedule ES
specify the schedule the collection data farm should run on:

Schedule Type:
Mo Schedule M

0K Cancel

2 Click Apply or OK.
The Collection Data Form is not scheduled to deploy.
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Date Specific
To deploy the Collection Data Form on a specified date:
1 Select Date Specific in the Schedule Type field.

Schedule Type:
‘ Date Specific v

Start Date(s):

[ Run event every year
[ Process immediately if dewice unable to execute on schedule

Select when schedule execution should start:
@ Start immediately at Start Time
O Start at a random time between Start and End Times

Start Time:| 1 % ;| 00 % |am * End Time: :
[Juse coordinated Universal Time | Current UTC 12:09 A8 ]

2 Click the +icon to the right of the Start Date(s) field to open a calendar, then select a date. To
select more than one date, click the + icon again. Click the - icon to delete a selected date.

3 (Optional) Select Run event every year to deploy the Collection Data Form annually on the dates
you selected.

4 (Optional) For some reason, if the event does not run on the schedule you configured, to trigger
the event immediately, select Process immediately if device unable to execute on schedule.

5 Select whether you want to deploy the Collection Data Form at a specified time or at a random
time between specified start and end times.

6 Specify a start time, and if you selected Start at a random time between Start Time and End Time,
specify an end time.

7 (Optional) Select Use Coordinated Universal Time (UTC). Recommended, if the management zone
is across geographical locations.

8 Click Apply or OK.

Recurring

Select whether you want to deploy the Collection Data Form when a device is refreshed, on certain
days of the week, monthly, or at a fixed interval.

To deploy the Collection Data Form when a device is refreshed:

1 Select Recurring in the Schedule Type field.
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Collection Data Form Schedule
Specify the schedule the collection data form should run on:

schedule Type:
‘Recurring v

@ ¥hen a device is refreshed

[Joelay execution after refresh: Days Hours Minutes

O Days of the week
Sun Mon Tue Wed Thu Fri 3at

Start Time:
more Options
O‘Munthlyr

Day of the month: |1
Last day of the month

Start Time:
Maore Options
O Fixed Interval
tonths Wieeks Days Hours winutes

start Date: I?,"ZID? Start Time:

#are Options

Ok Apply Reset Cancel

2 Select When a device is refreshed.

Schedule Type:
Fecurring hd

{5]When a device is refreshed

[(belay execution after refresh: Days Hours tinutes

3 (Optional) If you want to delay deploying the Collection Data Form for a set time after a refresh,
select Delay execution after refresh and specify the time in days, hours, and minutes.

4 Click Apply or OK.
To deploy the Collection Data Form on certain days of the week:

1 Select Recurring in the Schedule Type field.
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Collection Data Form Schedule
Specify the schedule the collection data form should run on:

schedule Type:
‘Recurring v

@ ¥hen a device is refreshed

[Joelay execution after refresh: Days Hours Minutes

O Days of the week
Sun Mon Tue Wed Thu Fri 3at

Start Time:
more Options
O‘Munthlyr

Day of the month: |1
Last day of the month

Start Time:
Maore Options
O Fixed Interval
tonths Wieeks Days Hours winutes

start Date: I?,"ZID? Start Time:

#are Options

Ok Apply Reset Cancel

2 Select Days of the week.

®Days of the week
S5un Mon Tue Wed Thu Fri Sat
Oooooooad
Start Time: |1 %[ 00 % |am ¥

tore Options

3 Select the days on which you want to deploy the Collection Data Form.
4 In the Start Time field, specify the time you want to deploy the Collection Data Form.
5 Click More Options.

@ Days of the week
Sun Mon Tue Wed Thu Fri Sat
OoO0ooogogaono
Start Time: |1 % [:| 00 % | am *
Hide Options

[JProcess immediately if device unable to execute on schedule
[Juse coordinated Universal Time [ Current UTC 9:56 PA |
[Jstart at a random time between Start and End Times

End Time:

[Jrestrict schedule execution ta the following date range:

Start Date: [§/29/07
End Date: [6/29/07
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6 (Optional) For some reason, if the event does not run on the schedule you configured, to trigger
the event immediately, select Process immediately if device unable to execute on schedule.

7 (Optional) Select Use Coordinated Universal Time (UTC). Recommended, if the management
zone is across geographical locations.

8 (Optional) If you want to deploy the Collection Data Form at a random time between a specified
start and end time, select Start at a random time between Start Time and End Time, then specify an

end time.

9 (Optional) If you want to restrict the deployment of the Collection Data Form to a certain date
range, select Restrict schedule execution to the following date range, then specify the start and end

dates.
10 Click Apply or OK.

To deploy the Collection Data Form monthly:

1 Select Recurring in the Schedule Type field.

Collection Data Form Schedule
specify the schedule the collection data form should run on:

Schedule Type:
‘Recurring v

@ When a device is refreshed
[Joelay execution after refresh: Days Hours Minutes

C Days of the week
Sun Mon Tue Wed Thu Fri Sat

Start Time:

tare Options

O‘Munthlyr
Day of the month: |1
Last day of the month

Start Time:
thore Options

O Fixed Interval
Months Wieeks Days Hours Minutes

start Date: I?,"ZID? Start Time:

Maore Options

Ok Apply Reset Cancel

2 Select Monthly.

%I Monthly
@ Day of the month: |1
O Last day of the month
O
Start Time: [ 1 % || 00 | am *

tore Options
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3 Select either Day of the month and specify a number between 1 and 31, Last day of the month, or
select the configurable field where you can choose a combination of days of the month for a
recurring schedule.

4 In the Start Time field, specify the time you want to deploy the Collection Data Form.

5 Click More Options.

@'N‘.onthlyr
® Day of the month: |1
O Last day of the maonth
o
Start Time: |1 % || 00 % |am v

Hide Options
[Jprocess immediately if dewice unable to execute on schedule
[Juse Coardinated Universal Tima [ Current UTC 9:56 Ph |
[start at a random time between Start and End Times

End Time:
[ restrict schedule execution ta the following date range:

start Date: [6/28/07
End Date: [6/28/07

6 (Optional) For some reason, if the event does not run on the schedule you configured, to trigger
the event immediately, select Process immediately if device unable to execute on schedule.

7 (Optional) Select Use Coordinated Universal Time (UTC). Recommended, if the management
zone is across geographical locations.

8 (Optional) If you want to deploy the Collection Data Form at a random time between a start and
end time, select Start at a random time between Start Time and End Time, then specify an end time.

9 (Optional) If you want to restrict the deployment of the Collection Data Form to a certain date
range, select Restrict schedule execution to the following date range, then specify the start and end

dates.
10 Click Apply or OK.

To send out the Collection Data Form at a fixed interval:

1 Select Recurring in the Schedule Type field.
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Collection Data Form Schedule
Specify the schedule the collection data form should run on:

schedule Type:

‘Recurring v

@ ¥hen a device is refreshed

[Joelay execution after refresh: Days Hours Minutes

O Days of the week

Sun Mon Tue Wed Thu Fri 3at

Start Time:
more Options
O‘Munthlyr

Day of the month: |1
Last day of the month

Start Time:
Maore Options
O Fixed Interval
tonths Wieeks Days Hours winutes

start Date: I?,"ZID? Start Time:

#are Options

Ok Apply Reset Cancel

2 Select Fixed Interval.

{31 Fixed Interval
0 |Months | O |weeks |0 |Days |0 |Hours |0 | Minutes

StartDate:IE,’ZSfD? start Time: |1 % |2 00 % | am +

hore Options

3 Specify the number of months, weeks, days, hours, and minutes in their respective fields.
4 Specify a start date and time.
5 Click More Options.

@ Fixed Interval

0 |sonths | 0 | weeks |0 |Days |0 |Hours |0 | Minutes

Start Date:lE,’ZSjD? Start Time: |1 % |: 00 | am »

Hide Options

[ process immediately if dewice unable to execute on schedule
[Juse Coordinated Universal Time
[ restrict schedule execution ta the following date range:

End Date: [6/23/07 End Time:

[ Current UTC 9:56 Ph )
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6 (Optional) For some reason, if the event does not run on the schedule you configured, to trigger
the event immediately, select Process immediately if device unable to execute on schedule.

7 (Optional) Select Use Coordinated Universal Time (UTC). Recommended, if the management
zone is across geographical locations.

8 (Optional) If you want to restrict the deployment of the Collection Data Form to a certain date
range, select Restrict schedule execution to the following date range, then specify an end date and end
time.

9 Click Apply or OK.
Event

1 Select Event in the Schedule Type field.

Schedule Type:
{Evernt v

Select the event that this schedule should be triggered on:

O User Login

O User Logout

O Device Boot

O on Device Lock

O on Device Unlack

O 7EMworks - Login

O ZENworks - Logout

O Device Connecting to Network [Windows Only)

2 Select one of the following:
¢ User login
¢ User logout
¢ Device boot
¢ Device shutdown
¢ On device lock
¢ On device unlock
¢ ZENworks Reauthorization - Login
¢ ZENworks Reauthorization - Logout
¢ Device connecting to network (Windows only)
3 Click Apply or OK.

4.3.2 Scheduling the Deployment of the Collection Data Form for Devices in
a Folder

1 In ZENworks Control Center, click Deuvices.

2 Click Details next to the folder whose devices you want to configure.
3 Click the Settings tab.

4 In the Settings panel, click Inventory > Collection Data Form Schedule.
5 Click Override settings.

This overrides the Management Zone settings.
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4.3.3

58

6 In the Schedule Type field, configure the schedule you want to use.
For configuring the schedule type, perform steps from Step 3 on page 50 through Step 3 on

page 57 listed in Section 4.3.1, “Configuring the Collection Data Form Launch Schedule for the

Management Zone,” on page 50.

Scheduling the Deployment of the Collection Data Form for a Device

In ZENworks Control Center, click Devices, then click the Managed tab.
Click the folder containing the device you want to configure a schedule for.
Click the device.

Click the Settings tab.

In the Settings panel, click Inventory.

In the Catalog list, click Collection Data Form Schedule.

~N o o~ WDN P

In the Inventory panel, click Override settings.

This overrides both the Management Zone and folder settings.

8 In the Schedule Type field, configure the schedule you want to use.

For configuring the schedule type, perform steps from Step 3 on page 50 through Step 3 on

page 57 listed in Section 4.3.1, “Configuring the Collection Data Form Launch Schedule for the

Management Zone,” on page 50.

4.4 Launching the Collection Data Form Using a Quick Task

Using a device Quick Task deploys the Collection Data Form to one or more devices in a folder.
To deploy the Collection Data Form using a device Quick Task:

1 In ZENworks Control Center, click Devices.

2 Click the folder containing the device you want to inventory.
3 Select the device or devices you want to inventory.

4 Click Quick Tasks > Inventory Wizard.

The Quick Task Status dialog box shows the progress of the deployment. When complete, the

Collection Data Form appears on the screen of the device or devices. You can stop the
deployment by selecting the workstation and clicking Stop.

ZENworks 11 SP3 Asset Inventory Reference



| QuickTask Status
MName: Inventory Collection Wizard Now
Created: Jul 8, 2007 12:18:06 PM
Status: 100% complete (2/2 devices)
] Hame Status Time
[0 @ zendocwksi Julg, 2007 11:18:12 &AM
O @ wksi Jul 8, 2007 11:18:07 AM
4] p]1-20f2 show 10~ items
Sion

5 Click Hide to close the dialog box.

4.5 Deploying the Data Collection Form Using a Device Task

Using a device task deploys the Collection Data Form to a specified workstation.
To deploy the Collection Data Form using a device task:

1 In ZENworks Control Center, click Devices.

2 Click the folder containing the device you want to inventory.
3 Click the device you want to inventory.

4 In the Device Tasks list, click Device Inventory Wizard.

The Quick Task Status dialog box shows the progress of the deployment. When complete, the
Collection Data Form appears on the screen of the device. You can stop the deployment by
selecting the workstation and clicking Stop.
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QuickTask Status x

Name: Inventory Collection Wizard Now
Created: Jul 8, 2007 12:03:20 PM
Status: 0% complete (01 devices)

[1 Name Status Time

[0 L2 zendocwks1 Assigned Jul 8, 2007 11:03:25 AM

1-10f1 show 10 * items

Hide

5 Click Hide to close the dialog box.

4.6 Scanning Demographic Data on an Inventory Only Device

Inventory Only Devices don’t use the Collection Data Form to gather demographic data.
Demographic data for an Inventory Only device must be entered manually into a file named
demodata.txt and saved on the device. This data is then gathered during an inventory scan.

You can scan for the demographic data only on Windows, Macintosh, and Linux.
To enable demographic data to be gathered from an Inventory Only device:

1 Create a file called demodata. txt.
The file should reside in the following location:
* For Windows, C:\Program Files\Novell\ZENworks\bin
* For Macintosh, /usr/local/novell/zenworks/umia
¢ For Linux, /opt/novell/zenworks/umia
2 Enter demographic data into the file using the format shown below.

The example below shows all the fields that can be included as well as various field formats;
however, only those fields that are actually entered need to be in the file. Examples of field
formats that are shown is as follows:

+ nc_user.ADF10 shows how to enter a date
+ nc_user.ADF11 shows how to enter a time
¢ nc_workstation.ADF10 shows how to enter currency

¢ nc_workstation.ASF11 shows how to enter a number (decimal or integer)

NOTE: Only those Administrator-Defined Fields that have been configured through ZENworks
Control Center have data from this file stored.
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[demodata ]

no.Masr.Tirstliane=John

RE.ResT Mdd LellamesT
Ro.Masr.Lastllame=nith

nc Maer.Email=jsmith@company. com
REMISE FRORES (KEK) REE-HEXE
nc_user.Phonels (KXX) XXX-XXEK EXEE
RELHISE. Dass [XRK) XX Rxax

nc_user.ADFO=
nc_user . ADFl=
nc_user.ADF2=
nc_user.ADF3=
nc_user.ADFd=
nc_user.ADFS=
nc_user . ADFa=
nc_user.ADFT=
nc_user.ADFE=
nc_user.ADF9=

nc_user.ADF10=1963-07-04T00:00:00
nc_user . ADF11=01:45 pm

nc_user.ADFl2=
nc_user.ADF1 3=
nc_user . ADFl4=
nc_user.ADFl5=
nc_user.ADFl &=
nc_user.ADF17=
nc_user.ADFl1 &=
nc_user ADF1 9=

DG.MOEEARARL AR, Ls=0tah

=0

DG MOEESEATLON. DEDAR LSRN
R MARkSEALLAR.CRAREenEEE=TS98T 65

nc_workstation.
nc_workstation.
nc_workstation.
nc_workstation.
nc_workstation.
nc_workstation.
nc_workstation.
nc_workstation.
nc_workstation.
nc_workstation.
nc_workstation.
nc_workstation.
nc_workstation.
nc_workstation.
nc_workstation.
nc_workstation.
nc_workstation.
nc_workstation.
nc_workstation.
nc_workstation.

ADFO=
ADFl=
LDF2=
LDF3=
ADF4=
LDF5=
LDFé=
EDFT=
ADFE=
ADF3=
ADF10
ADF11
RDF1Z
ADF13
RDF14
RDF1S
BDFl6
ADF17
ADF1E
ADF19

= (XHX) XHX-X KK

=% 2322.45
=10.0

3 Save the file.

4 Configure and run un an Inventory Only scan as shown in Section 3.1, “Configuring an

Inventory Only Scan,” on page 31 and Section 3.2, “Scheduling an Inventory Only Scan,” on

page 34.
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Importing Demographic Data

Importing demographic data is the process of automatically populating the Novell ZENworks
database with demographic information from Microsoft Active Directory and Novell eDirectory. The
demographic information is made up of the inventory data associated with users, workstations, or
other entities.

For information on the supported versions of Microsoft Active Directory and Novell eDirectory, see
“LDAP Directory Requirements” in the ZENworks 11 SP3 System Requirements.

This section includes the following topics:

¢ Section 5.1, “Creating LDAP Import Tasks,” on page 63
¢ Section 5.2, “Executing LDAP Import Tasks,” on page 70
¢ Section 5.3, “Viewing or Editing LDAP Import Tasks,” on page 70

Creating LDAP Import Tasks

1 In ZENworks Control Center, click Configuration > Asset Inventory.

4 Home
M Devices Configuration Registration System Information Asset Inventory Asset Management System Updates Locations Subscriptions
A Users
5 Palicies Knowledge Base Status =
; >
Bundles =
® Patch Management S
% Deployment The date of the most recently applied PRU is Septemnber 1, 2010 12:00:00 AM (version 3.6.4.1¢).
|2 Reports There has not been a KB Merge.
B Asset Management Local Software Products A
& Endpoint Security
it o Manufacturer Product = Version File Installations
Message Cleanug No items available.
Download ZEMwarks Tools
F 1y Used w Administrator-Defined Fields Py
requently Use: A
Type Fields
B bl srmeslab173 L
User o
Wiorkstation [¢}
Component o
Product o
LDAP Import Tasks ES
[] Hame = Schedule Status Devices Mapped
O ¢ Loap_import_Taski RuN Now pending 0
4| ®]1-1010 show 5 v items

2 Inthe LDAP Import Tasks panel, click New to launch the New LDAP Import Task Wizard.
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3 Complete the wizard by using information from the following table to fill in the fields.

Wizard Page

Details

Define Details page

Enter LDAP Settings page >
Search pre-configured LDAP
source option

Fill in the following fields:

+ Name: Provide a unigue name for the import task. The name
cannot include any of the following characters: /\*? :""'<> |~
0% ~

If you want to use numeric characters in a name, you must
include characters like _, #, or * between the name and
numeric value. A numeric value cannot immediately follow an
alphabetic character. For example, if there is an existing task
named ABC, you can create a new task with a name ABC_1
but not ABC1.

+ Description: Provide a short description for the import task.
This description is displayed in the LDAP Import Task Details
panel of ZENworks Control Center.

The Enter LDAP Settings page lets you identify the LDAP directory
against which you want to perform the import task.

A preconfigured LDAP source is one that has already been defined
as a user source in your Management Zone. For information on how
to create a user source, see “Adding User Sources” in the
ZENworks User Source and Authentication Reference.

If you want to create a new connection to the LDAP directory, see
“Enter LDAP Settings page > Specify a new LDAP source option” on
page 65.

LDAP b B, LD fonprt_Eask)
& Siop 1 Dntes LBAP Sotiiogs

To use an existing connection to the LDAP directory:

1. Select Search pre-configured LDAP source from the drop-
down list.

2. Inthe Source to Search list, select the LDAP source you want
to search.

The Source to Search list contains only the directories that
have been defined as user sources within your Management
Zone.
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Wizard Page

Details

Enter LDAP Settings page >
Specify a new LDAP source
option

The Enter LDAP Settings page lets you create a hew connection to
the LDAP directory to import inventory information.

A new LDAP source is one that was defined as a new source when
the import task was created.

If you want to use an existing connection, see “Enter LDAP Settings
page > Search pre-configured LDAP source option” on page 64.
To create a new connection to the LDAP directory:

1. Select Specify a new LDAP source from the drop-down list.

2. Fill'in the following fields:

LDAP Server: Provide the IP address or DNS hostname of the
server that has the LDAP directory installed.

LDAP Port: Select the LDAP port number. The default is the
standard SSL port (636) or non-SSL port (389), depending on
whether this option is enabled or disabled. If your LDAP server
is listening on a different port, select that port number.

LDAP Root Context: Provide the root context to establish the
entry point in the directory. If you do not provide a root context,
the directory’s root container becomes the entry point.

Credentials: Provide the credentials to acquire read-only
access to the directory. You can have more than read-only
access, but read-only access is all that is required and
recommended.

When accessing eDirectory, ensure that the account has read
rights to the following:

+ WM:NAME DNS attributes on the workstation and server
objects

+ All those attributes you want to import
To add the credentials:

a. Click Add to display the Enter Credential Information
dialog box.

b. In the Type drop-down list, select LDAP.
c. Inthe Username field, specify the appropriate username.

For Novell eDirectory access, use standard LDAP
notation. For example,
cn=admin read only,ou=users, o=mycompany

For Microsoft Active Directory access, use standard
domain notation. For example,
AdminReadOnly@mycompany .com

d. Inthe Password and Reenter Password fields, specify
the user password.

e. Click OK.

3. (Optional) To save the credentials, select the Save credentials
to datastore option.

The saved credentials are encrypted in the database for
increased security.
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Wizard Page

Details

Map Fields page > Key
option

Credentials that are not saved are cleared from memory when the
ZENworks Server is restarted. If you are creating a scheduled
import task, you should save the credentials to ensure that they are
still available when the import task is performed.

IMPORTANT: If an optional field is defined in the LDAP directory, it
must be included in the dirimport .xml file on the ZENworks
Server to make it available in the LDAP Fields list. For more
information, see “Optional fields are not visible in the LDAP Fields
list in ZENworks Control Center” on page 124.

The Map Fields page displays the LDAP directory fields on the left
and ZENworks Inventory fields on the right. The ZENworks
Inventory Fields list displays the following information:

+ A small subset of possibly hundreds of classes defined in your
LDAP source, showing only those relevant to ZENworks Asset
Inventory.

+ All the Workstation and User administrator-defined fields.

The Key option lets you define a key assignment for the LDAP
Import task. You must define a key assignment for each task to
uniquely identify the mapped fields. You can define only one key for
each task.

Key is a unique value that is assigned by mapping an LDAP field to
a unigue ZENworks Inventory field. When a task runs, the key field
is searched for the stored key value. If the key is unique, the data
from the specified LDAP fields is imported to the specified
ZENworks Inventory fields. If the key is not unique, only the first hit
is selected for mapping, which might result in incorrect mappings.

To define a key assignment:
1. Inthe LDAP Fields list, locate the field.

2. In the ZENworks Inventory Fields list, select a corresponding
key field from a similar class.

All workstation-based LDAP fields can be mapped only to the
ZENworks Inventory fields belonging to a Device class.
Similarly, all user-based LDAP fields can be mapped only to
the ZENworks Inventory fields belonging to a User class. Thus,
you need to create two independent tasks for workstation-
based and user-based fields.

For example, while importing data from Active Directory, you
want to define a key for the LDAP field called name belonging
to a computer class (which is unique across the organization).
You can select the ZENworks Inventory field called Machine
Name belonging to a Device class.

3. Click Key.

After you define a key, “= [LDAP Fields class] / [LDAP Fields
name]” is appended to the selected ZENworks Inventory field.

For example, if you want to define the LDAP field called name
belonging to a computer class and the ZENworks Inventory
field called Machine Name belonging to a Device class as the
key fields, the Inventory Device class Machine Name field
changes to Machine Name = computer / name.
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Wizard Page

Details

Map Fields page > Map
option

The Map option lets you map one or more LDAP directory fields to
the corresponding fields in the ZENworks Inventory database.

To map an LDAP directory field to the corresponding ZENworks
Inventory field:

1. Inthe LDAP Fields list, locate a field you want to map.

2. In the ZENworks Inventory Fields list, select a corresponding
field from a similar class.

All workstation-based LDAP fields can be mapped only to the
ZENworks Inventory fields belonging to a Device class.
Similarly, all user-based LDAP fields can be mapped only to
the ZENworks Inventory fields belonging to a User class. Thus,
you need to create two independent tasks for workstation-
based and user-based fields.

For example, while importing data from Active Directory, you
want to map the LDAP field called displayName belonging to a
user class. You can map it to the ZENworks Inventory field
called First Name belonging to a User class.

3. Click Map.

LI bt s LIAA8 P
* Targ 1 g Pl

After you map the fields, “<- [LDAP Fields class] / [LDAP Fields
name]” is appended to the selected ZENworks Inventory field.

For example, if you want to map the LDAP field called
displayName belonging to a user class to the ZENworks
Inventory field called First Name belonging to a User class, the
ZENworks Inventory User class First Name field changes to
First Name <- user / displayName.

If the size of the selected LDAP field exceeds the size of the
corresponding ZENworks Inventory field, the data is truncated
to the maximum size of storage and an error message is
displayed in the Last Import Messages column. For more
information on the error, see the 1loader-messages.log file
located in the $ZENWORKS HOME%\logs\ directory on
Windows or see the /var/opt/novell/log/zenworks/
loader-messages. log file on Linux.

4. (Optional) To map additional fields, repeat Step 1 through Step
3.
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Wizard Page Details

Map Fields page > Remove  To remove a field mapping:

option 1. Inthe ZENworks Inventory Fields list, click a mapped field that
you want to remove.

2. Click Remove.

To remove a key assignment from the selected field:

1. In the ZENworks Inventory Fields list, click a field that is
defined as a key.

2. Click Remove.

You must again define a key to uniquely identify the mapped
fields. For more information, see “Map Fields page > Key
option” on page 66.
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Wizard Page Details

Set the Import Schedule Configure the schedule when you want to run the import task, then
page click OK.

LA bpent Rashs | LIAP_hpart_Task
% g 4t e g S e

+ To immediately run the task after it is created, click Now.
+ To set up a schedule:

1. Click On a schedule, then select one of the following
schedules:

+ No Schedule: Indicates that no schedule has been
set. The task does not run until a schedule is set or
the task is manually launched. This is useful if you
want to create the task and come back to it later to
establish the schedule or run the task manually.

+ Date Specific: Specifies one or more dates on
which to run the task.

* Recurring: ldentifies specific days each week,
month, or on a fixed interval on which to run the
task.

IMPORTANT: Ensure that you do not set the same
schedule for multiple tasks. If done, the scheduled
tasks might not run. For more information, see
“LDAP import tasks remain in a pending state if they

run simultaneously” on a(rge 120, .
B Importing Demographic Data
2. (Conditional) If you selected Date Specific or Recurring

for the schedule, fill in the schedule’s fields.

For more information on the schedules, click the Help
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5.2

5.3

Wizard Page Details

Select Primary Server page  Select the ZENworks Server that you want to perform the LDAP

import task.
B ben e
= o
e
0 Brdten
& Prich Manape: - Y
Coplaymars
s
Lot strem.

When you finish the wizard, the import task is listed in the LDAP Import Tasks panel. You can use
the panel to monitor the status of the task. If the key is unique, the data from the LDAP fields is
imported to the ZENworks Inventory fields based on the mapped assignments.

IMPORTANT: Before running a task, ensure that all the existing tasks are in a finished state. For
more information, see the troubleshooting scenario “LDAP import tasks remain in a pending state if
they run simultaneously” on page 120.

Executing LDAP Import Tasks

You can execute an LDAP import task in two ways:

Schedule - based: For a schedule based import task, you need to configure a schedule. For more
information, see “Set the Import Schedule page” on page 69.

Manual: To manually execute an import task, perform the following steps:

1 In ZENworks Control Center, click Confiquration > Asset Inventory.
2 In the LDAP Import Tasks panel, select the import task you want to execute.
3 Click Action> Launch Import Task.

Viewing or Editing LDAP Import Tasks

To view or edit the LDAP import task settings:

1 In ZENworks Control Center, click Configuration > Asset Inventory.
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Administrator  Help

7 Home
ﬁ Devioes Configuration Registration System Information Asset Inventory Asset Management System Updates Locations Subscriptions
A Users
& Policies Knowledge Base Status £
=
B! Bundles =
@ Patch Management SEHEE
% Deployment The date of the most recently applied PRU is Septernber 1, 2010 12:00:00 &M (version 3.6.4.16).
|2 Reports There has not been a KB Merge,
- . Local Soff Prod: A
twi 1
B Asset Management il il -
& Endpoint Security
. File i
T 7 Manufacturer Product = Version i Installations
Message Cleanup No ftems quailabie.
Download ZEMwarks Tools
Administrator-Defined Fields A
Frequently Used PS = o
e ields
B bir-srm-slabi73 2
User [}
wiorkstation [2}
Coampaonent o
Product [1}
LDAP Import Tasks A
[] Mame = Schedule Status Devices Mapped
O ¢ Loap import Taskt Run Now pending 0
4| r]1-1081 show 5+ items
2 In the LDAP Import Tasks panel, click a task to view or edit its settings.
LDAP Import Tasks > Test v
« Test
Summary Results
LDAP Import Task Details A

GUID: 0720a4ca61b7 aebe’ 240e0cded9dhdee

Description: (Edit) Test Description

Primary Server: (Edit) gystetzen-234

Schedule: (Edit) Schedule Type: [~
Date Specific =

[~
Configured LDAP server: {Edit) 164.99.180.92
Mappings: (Edit) NC_Workstation.Site <- Computer.l

NC_Workstation.MachinelName =
Computer.cn

The Summary tab lists the settings configured for the task:

*

GUID: Displays the task’s globally unique identifier (GUID), which is a randomly
generated string that provides a unique identifier for the task. You cannot edit the GUID. It
remains the same as long as the task exists.

Description: Displays the task’s description, if one was provided when the task was
created. The description appears only in ZENworks Control Center.

Primary Server: Displays the name of the ZENworks Server that is assigned to perform the
discovery task.

Schedule: Displays when the task is scheduled to run.

Configured LDAP Server: Displays the IP address of the server that hosts the LDAP-based
directory server.

Mappings: Displays all the mapped and key assignments established between the LDAP
directory and ZENworks Inventory fields.

3 (Conditional) If the information for a device is incorrect or insufficient, click Edit and manually
change the details for the fields.
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If you configure another LDAP server, some of the mapped and key assignments might become
incorrect. In this case, you must verify the assignments and map the fields again.

For more information on how to map the fields, see “Map Fields page > Map option” on page 67.

For more information on how to define a key assignment, see “Map Fields page > Key option”
on page 66.
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6.1

6.2

Creating Local Software Products

The following sections provide information about Local Software Products:

¢ Section 6.1, “Understanding Local Software Products,” on page 73

¢ Section 6.2, “Understanding the Local Software Products Panel,” on page 73

*

Section 6.3, “Creating Local Software Products,” on page 74

*

Section 6.4, “Consolidating Local Software Products,” on page 76

*

Section 6.5, “Editing Product Information,” on page 76

*

Section 6.6, “Updating the ZENworks Knowledgebase,” on page 79

*

Section 6.7, “Creating a New Software Fingerprint Request,” on page 81

Understanding Local Software Products

Software applications discovered in an inventory scan are identified by specific files associated with

the product. These identifications are kept locally in the ZENworks Knowledgebase, which can be
updated by downloading and installing the latest Product Recognition Update (PRU).

To identify products that aren’t in the Knowledgebase, you can search for files that are associated

with an unknown product and use the file information to create a new product identification called a

Local Software Product. This Local Software Product information can then be merged with the
knowledgebase so that these new products are recognized in subsequent scans.

Understanding the Local Software Products Panel

To access the Local Software Products panel, click Configuration in ZENworks Control Center, then
click the Asset Inventory tab.

Figure 6-1 Local Software Products Panel

Local Softwara Products #

[ Maufacturar Product = Version e Installatiors

™ Business Objects Business View Manager 11.5.8.826 CRYSTALREPOWIZ.EXE 0
™ thapinfo tiapinfi api 3.52.49 MIGMI0EXE 0
™ Analog Devices, Inc. ShandPHP Application 5,2,0,5 SHALNAPND EXE o
™ TEMCENT TENCENT 00 ©0,0,0,0 QULEXE 0
™ Fired B irving Inc. Testing Apo 1.00 EX034. DX JUCHECH. BXE o

CONFIGWIZARDS EXE
b 1-Bafk f— T

This panel shows Local Software Products that have already been created, along with the following
details:

¢ Manufacturer: The manufacturer of the product.

¢ Product: The name of the product. Click the product name to open the Local Software Product
Detail page where you can edit product and file details.
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¢ Version: The product version.
¢ File: A list of files associated with the product.

+ Installations: The number of installations of the Local Software Product in the Management
Zone.

6.3 Creating Local Software Products

Local Software Products are created from software files associated with a product. Before you can
create a Local Software Product, you need to run an inventory scan that has been configured to
search for those files. For information on configuring and running an inventory scan, see Chapter 2,
“Scanning Managed Devices,” on page 11 and Chapter 3, “Scanning Inventory Only Devices,” on
page 31.

To create, edit, or delete a Local Software Product, you need the Create/Delete Local Products rights
enabled from the Management Zone > Zone rights.

To create local software products:
1 In ZENworks Control Center, click Configuration, then click the Asset Inventory tab.

Local Softwara Products #

™ Msnulscturer Product = Version Tike Torstallatiurs.
[T dusiness Objects Businass view Manager 11.9.8.826 CRYSTALREPOWIL EXE

0
™ thapinfo tiapinfo Map 3.52.49 MIGMI0EXE 0
™ Analog Devices, Inc. ShhandPHP Application 5,2,0,5 SHAYAPND EXE o
™ TENCENT TENCENT Q0 0,0,0,0 QULEXE 0
™ Fired B irving Inc. Testing pn 1.00 EXo3a. DX JUCHECH. EXE o

CONFIGWIZARDS, EXE
b 1-Bafk f— T

2 In the Local Software Products panel, click either New > Create from Software Files by Machine or
New > Create from Unique Software Files.

Clicking Create from Software Files opens a report definition that you can run to list all the
software files on each machine in the Management Zone according to the way the inventory scan
was configured.

Clicking Create from Unique Software Files opens a report definition that you can run to list all the
software files that are not associated with a known software product as identified in the
ZENworks Knowledgebase. The files are identified using Version Recognition Block (VRB)
product information.

74 ZENworks 11 SP3 Asset Inventory Reference



Custom Report Definition Summary: Software Files by Machine

Description

Type

Columns

Criteria

Creator

Creation Date

Last Run Date

Run Edit Close

3 Click Run.

Software Files by Machine

Software Files, focusing on All Files Found
1to 100 of 844 Records with:

Device |s Deleted =

O Machine

Select Hame

[m] ZENDOCW S
ZENDOCWES1
ZENDOCW S
ZENDOCWES1
ZENDOCW S
ZENDOCWES1
ZENDOCW S
ZENDOCW S
ZENDOCW S
ZENDOCWES1
ZENDOCW S
ZENDOCWES1
ZENDOCW S
ZENDOCW S
ZENDOCW S

Oocooooooooooan

O

Edit Report Definition Excel Excel (All} CSV CSV {(Al) PDF

Mo

File

Hame
ZISIIN
UPDATE
SPUMINST
SPUMINST
SPUMINST
SPUMINST
MSBUILD
ZPA_IFACE
TOURSTART
SPUPDYWARP
MAWT RAY
METSETUP
FsUTIL
CYDUPGRD
1P

Lists software files on each machine, Local

products can be created from this list,

Software Files, focusing on &ll Files Found

Machine Name

File Mame

File Extension

File Folder

Device Iz Deleted = Mo

T2y
TIA07

File
Extension

EXE
EXE
EXE
EXE
EXE
EXE
EXE
EXE
EXE
EXE
EXE
EXE
EXE
EXE
EXE

Run Date: 7/5/07

File
Folder

Lo T T T o T T o R N R S S S s

WPROGRARM FILES\NOVELLVZ ENWORKSA\BINYVPREBOOT
WAITNDOWS SHF _MIGS\KBI00T25WUPDATE
WAITNDOWS SHF _MIGSWKBI08E31

WAITNDOWS SNTUNINSTALLKBR10437_0SWSPUNINST
WATNDOWS W SNTUNINSTALLKBR 115655 SPUNINST
WATMDOWSASNTUNINSTALLKES1 344 650SPUNINST
WMTNDOWS WAL CROSOFT . NETAFRAMEWORK W2 0, 50727
WMMTNDOWSNOVEL LAZ ENVWIORKSVSTAGE
MAMTNDOWSASYSTEMIZ

MAMTNDOWSASYSTEM3Z

MAMTNDOWSASYSTEMIZ

MAMTNDOWSASYSTEM3Z

MAMTNDOWSASYSTEMIZ

WMTNDOWSASYSTEM3Z

UM MDOWSASYSTEMIZ

PDF {All) Create Local Products Close

4 Select the files you want to use to create Local Software Products.

This page also allows you to edit the report definition and export the records to Excel, CSV, and
PDF formats. For more information on editing the report definition, see Section 8.2.6, “Editing a
Custom Report,” on page 98.

5 Click Create Local Products.

A dialog box appears, confirming that the products have been created.

Make Local Products

1 local products have been created.

Close |
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6 Click Close.
The selected products appear in the Local Software Products panel on the Configuration page.

6.4 Consolidating Local Software Products

If you have several files in the Local Software Products panel that identify the same product, you can
consolidate them into one.

To consolidate two or more files:

1 In ZENworks Control Center, click Configuration.
2 Click the Asset Inventory tab.

3 In the Local Software Products panel, select the files you want to merge.

Local Softwara Products

™ Msnulscturer Product = Version e Torstallatiurs.
M Buginess Objects Busingss View Manager 11.5.8.826 CRYSTALREPOWIL EXE 0
™ hhapinfo apinfia Mapx 3.52.49 MGMI0EXE 0
™ analog Devices, Inc. ShhandPHP Application 5, 2,0,5 SHAASAPND EXE o
[T TEMCENT TENCENT 90 o000 QQ.EXE 0
N EMO3A.EXE JUCHECK.EXE

r i 2400

Fired & Irving Inc. Testing & 1.00 O GRS e a

b 1-Baf R choss W0 = ibam

4 Click Action > Merge Selected Products.

Merge Local Software Products

Select the target product

Target Product: v |
0K

5 Select a target product in the Target Product field.

6 Click OK.
The target product is displayed with its component files, which are shown in the File column.

6.5 Editing Product Information

ZENworks Control Center allows you to edit both product naming data and product recognition
data of a local software product. For more information, see the following sections:

¢ Section 6.5.1, “Editing the Product Naming Data,” on page 76
¢ Section 6.5.2, “Editing the Product Recognition Data,” on page 78

6.5.1 Editing the Product Naming Data

76

1 In ZENworks Control Center, click Configuration.
2 Click the Asset Inventory tab.

3 In the Local Software Products panel, click a product.
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Local Soltware Product Delail #

Product Naming
Manulachurer [Hapinta =

Product: |Mepinta Magi

Varshon: [s2.48 [l Use for Version Reporting
Categary/Subcategory: [Cther Somware f Other |

Distribution: -

License Type: =+

Current Manfactirer: [Mapints

= Product Recognition

I~ rie
[t el

Last Mod

0K

The Local Software Product Detail page shows details about the local software product and the

size Date VEn Verson Reporting

M0, EXE ] ERRRTH Mapinfo Mapinfo Mapx 3.52.4% r

itted: [Tamr

Apply Meset Cancel

files used to identify it. From here, you can edit the product information or the Version
Recognition Block (VRB) data for the identifying files. If the file associated with the product does

not ¢

ontain Version Resource Block (VRB) information, the fields show “Unnamed.”

Edit the fields in the Product Naming section.

Product Naming
Manufacturar: |Maginta &
Product: [Mapinto Mapix
Verrsinn: |352.43 1 use for version Reporting
Category/Subcategory: [Cmer Sottware / Ctner |
Distribution: =
License Type |
Current Manufacturer: [Mapinto
Manufacturer: The manufacturer of the product.

Product: The name of the product.

Version: The version of the product.

Category/Subcategory: The type of product. You can create your own categories and
subcategories. For more information, see Section 10.3, “Managing Product Categories and

Subc

ategories,” on page 109.

Distribution: The type of distribution:

*

*

*

*

*

*

Commercial
Freeware
Shareware
Open Source
Multiple

Public Domain

License Type: The software product’s license type:

*

*

*

*

*

Full
Evaluation
OEM
Multiple

Network License

Current Manufacturer: The product’s current manufacturer.
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Use for Version Reporting: Select Use for Version Reporting to use the product version for
recognition purposes. You can use either the product version or the file version for recognition
purposes. If you want to specify a version in the Version field to be used in the product definition,
specify a value and select Use for Version Reporting. You can use either the product version or the
file version for identification. To use the file version, select Version Reporting in the Product
Recognition section.

5 Click Apply or OK.

6.5.2 Editing the Product Recognition Data

1 In ZENworks Control Center, click Configuration.
2 Click the Asset Inventory tab.
3 In the Local Software Product panel, click a product.

Local Saftware Product Detail =
Broduct Naming
Monulfocturer: [Froet & rving Inc E
Produet: [Tasting App
Verrsion: |10 T uee for versian Reporting
Category/Subeategory: | Other Sofware | Cther =
Distribution: OpenSouce 3]
Liconta Type Full -
Currant Manufacturer: [Fired & Inving Inc
~Product Recognition
e Sre Date VRD ¥ersion Reporting
T CONFIGWIZARDS. EXE L LU AR 1.0.5000.0 r
I Eoan. EXE ['] TIor Fired & irving Ine. Tacting App 1.00 =
™ JUCHECK EXE o rar updateChecker Maduls 1, 0, 0, 1 r
Last Medified: (712007

OF. Apply Fasar Cancel

4 In the Product Recognition section, select the file you want to edit. If you want to use the file
version for version reporting instead of the product version, select Version Reporting for that file.

—Product Recognition-

I ras £ Date vl Varsian Reporting
™ CONFIGWITARDS. EXE o TIoT 1.0.5000.0 r
M o BE o TI0T Fjred & Irving Inc. Testing App 1.00 =
™ JUCHECK.EXE o TIN0T Updatechecker Module 1, 0, 0, 1 r

5 Click Edit.
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6.6

Edit Product Recogpition File
—File Attribu
File: [Exn3a
Extension: |E><E
Size: 0 %
Date: 7
—Wersion Resource Block [VRE] Data
Company Name: IFJrEd & Irving Inc. ™ use for recognition
Product Name: ITESImgApp ¥ Use for recognition
Product ersion: |1 00 ¥ Use for recognition  ® Report the version found here
File Version: IT.UU ™ Use for recognition € Report the version found here
Language: - ™ Use for recognition

6 Edit the File Attributes fields.

File: The name of the file.

Extension: The file’s extension.

Size: The size of the file. Use the arrow icons to change the file size.

Date: The date the file was created. Click the calendar icon to select a different date.
7 Edit the Version Resource Block (VRB) data.

Company Name: The manufacturer of the file. To use this data as part of the recognition criteria,
select Use for recognition.

Product Name: The name of the product. To use this data as part of the recognition criteria,
select Use for recognition.

Product Version: The version of the product. To use this data as part of the recognition criteria,
select Use for recognition. To use the product version instead of the file version for recognition,
select Report the version found here.

File Version: The version of the file. To use this data as part of the recognition criteria, select Use
for recognition. To use the file version instead of the product version for recognition, select Report
the version found here.

Language: The associated language. The available languages are shown in the drop-down list.
8 Click OK on the Edit Product Recognition File page.
9 Click OK on the Local Software Product Detail page.

Updating the ZENworks Knowledgebase

The ZENworks Knowledgebase is updated in several ways:

¢ Section 6.6.1, “Merging Local Software Products with the ZENworks Knowledgebase,” on
page 80
¢ Section 6.6.2, “Updating the ZENworks Knowledgebase with the PRU,” on page 80
The Knowledgebase Status panel (Configuration > Asset Inventory) shows the date of the latest Product

Recognition Update (PRU) and if there are newly defined local software products ready to merge
with the Knowledgebase.
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Figure 6-2 Knowledgebase Status Panel

»

Knowledge Base Status

—
e
Status

The date of the most recently applied PRU is May 2, 2007 [version 3.6.8.186),

There are changes to the KBs that are ready to be merged.

6.6.1 Merging Local Software Products with the ZENworks Knowledgebase

After a Local Software Product is created, you can add it to the ZENworks Knowledgebase so that

subsequent scans identify the product on devices. The Knowledgebase Status panel on the Asset

Inventory page (Configuration > Asset Inventory) shows when there are products ready to be merged.
1 In ZENworks Control Center, click the Configuration tab.

2 Click the Asset Inventory tab.

Local Softwara Products #

[T Hawlsturer Product = Wersion Tike Installatiors

[T dusiness Objects Businass View Manager 11.5.8.826 CRYSTALREPOWAL EXE o

™ Hapinfo Mapinfo Map 35249 MIGMO.EXE a

[ Analog Devies, Inc. ThAadPHP Application B, 2,0, 8 THAXAPND EXE o

[T TEMCENT TENCENT 90 o000 QQ.EXE 0
X034, EXE JUCHECK, EXE

7 Fired & irving iInc. Testing App 1.00 CONFIGWIZARDS. EXE a

i|»|1-80r8 f— T

3 In the Local Software Products panel, select any local product you want to merge.

4 Click Action > Update Knowledgebase with Local Product Changes.A message appears to remind you
that updates should only be made after all local product changes are complete. For information
on editing local product data, see Section 6.5, “Editing Product Information,” on page 76.

5 Click OK to merge the listed software products with the Knowledgebase.

NOTE: When you select a local product for merging, changes to other local products are also
merged with the ZENworks Knowledgebase.

6.6.2 Updating the ZENworks Knowledgebase with the PRU

To make sure that your ZENworks Knowledgebase is up-to-date, ensure that the latest PRU is always
deployed in your zone.

1 To download and deploy the latest PRU, log in to ZENworks Control Center, click Configuration
> System Updates.

Configuration Registration  System Information  Asset Inventory  Asset Management  System Uipdates.

J Devices

oy Users

7] Policies Available System Updates #
d Bundles

< Patch Management | || Updsts Hanie o Relsase Date Duwnload Date Applied Date Status =portande Tariet Type

% Ceployment ™ may 2012 PRU M3 1, 2012 May 15, 2012 May 15, 2012 Baselined Modarate All Devices

il Reports I Support Pack 2 for ZCM {10.2) May 27, 200% i d All Devices
({8 Configuration .. [ update for 70 [10.1.1] Oct &, 2008 datory All Darvices

2 Click Action > Check for Updates. It might take some time to connect and get the request from the
server.

3 The new PRU is visible on the System Updates page. To download the update, click Action >
Download Update.
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6.7

6.7.1

4 Verify that the update is in the directory where you downloaded it, then click Action > Deploy
PRU Now.

5 To verify the status of the PRU, go to Configuration, then click Asset Inventory > Knowledge Base
Status.

The Knowledge Base Status should be similar to the following graphic:

& Home
[ Devices

L Users
[l Policies Knowledge Base Status
J Bundles —

Configuration Registration System Information Asset Inventory Asset Management System Updates

<3 Patch Management S

7 Deployment The date of the most recently applied FRU is May 1, 2012 12:00:00 AM (version 3.6.4.16).
= Reports The KBs were last merged on May 15, 2012 11:53:53 AM,
{8 Configuration

e Local Software Products

6 Refresh the server and the agent and run a scan.

7 Go to the Inventory Details page and verify that the required software appears in the inventory
list.

Creating a New Software Fingerprint Request

Although, each monthly Product Recognition Update (PRU) release cycle identifies many new
software applications, it is not practical to include every possible application that is released.
Limitations include software being licensed, software that is not yet covered as part of our PRU focus,
and software that is released by vendors that are not well-known. To bridge these gaps you can use
the SWID (Software Identification) utility to collect the necessary metadata to create a new software
fingerprint request.

If software is unrecognized after you deploy the latest PRU, you can use the utility to create a
Software Identification (SWID) file of the unrecognized software and send it to the Novell
Fingerprint Support Team zam_support@novell.com.

Working with the SWID Wizard

You can request a software fingerprint by using the SWID Wizard, which scans configured locations
on a workstation and looks for information about a particular piece of software. The output files from
this utility are then sent to Novell for inclusion in the monthly PRU releases.

The SWID Wizard can scan locations on a remote machine, but only if you are logged into both the
machines. For example, if you are running the probe from machine A and are attempting to reach
machine B, you must be logged into both machines with the same account.

¢ “Preparing to Use the SWID Wizard” on page 82

¢ “Using the SWID Wizard” on page 82

¢ “Posting the SWID File” on page 84

¢ “Verifying When New Software Is Included in the PRU” on page 84
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Preparing to Use the SWID Wizard

1 Before initializing the SWID Wizard, start each application you intend to run the SWID Wizard

on.

2 From the Help menu of each application, open the About screen and capture it as a screen shot.

3 Save this screen shot as a bitmap file.

Using the SWID Wizard

1 Download the SWID Wizard from the Novell Downloads Web site (http://download.novell.com/
Download?buildid=esvnGon5e9Q)).

2 Save the SWIDWizard.exe to a temporary directory.

3 Browse to the temporary directory and double-click SWIDWizard.exe. The Software
Identification Wizard is displayed.

. Novell Software Identification Wizard - User Information o ] S
— Uszer Infarmation
Company Mame™ ||
Ernail Address™ : I
* required
— Dptionz
The output files will be written to the fallowing path:
Path: [P:\SWwID Change Path |
Enter a path (indude a drive) for the output and log |
The log file will be written to the following location:
F: 45w DA S Diedizard log
V¥ Automatically return output file to Hovell

Cantinue Help Euit

4 In the User Information dialog box, specify the following details:

4a
4b
4c
4d

Company Name
Email Address

Path where the output files will be stored.

Select Automatically return output file to Novell if you have Internet access from this machine,
or deselect it if you do not. If the SWID needs to be stored locally rather than sent to the
Novell Web site, ensure that the check box is deselected.

The SWID is stored in the path you indicated in Step 4c.
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4e

Click Continue.

=, Novell Software Identification Wizard - Product Information ;Iglil

r— Product

Bugzilla Mumber: || (If a Humber Has Been Aszigned]

— Search Location:
" Local Machine Femote Machine € Nebware Server

Browse Wetwark... |
Remate kachine Mame: I

Search Pathe Add Path |
Remave Fath |

™ Inchude Files without an Extenzsion Extensions |

— Search Text

M anufacturer ; I ﬂ [Example: Microsoft not Microsoft Corparation)
Product® : I [Example: Outlook not Outlook Exchange)
Wersion® ; I [t ajor.Minor - Example; 4.2 not 4,23 00E)

Language® : [Example: Englizh)

E ditint: I [Example: Prafessional)

Additional Search Text: Add Text |

Serial Mumber: I
Screen Shot File: I [Example: Help-=4bout) Browse... |
Comment: I
* required
Add Anather Product | Clear Fields | Continue | Help Exit

5 In the Product Information dialog box, specify the following details:

5a
5b
5c
5d
5e

5f

59

5h
5i

5
5k

Select either Local Machine or Remote Machine.
Paths where you want to search for software.
Product Name

Version

Language

Edition

(Optional) To add text strings to search for additional information about the application,
click the Add Text button and the text in the Add Text dialog box.

or

Remove text strings by selecting one or more strings and clicking the Remove Text button.

(Optional) Serial Number

Browse to and select the screen shot file you created in “Preparing to Use the SWID
Wizard” on page 82.

(Optional) Provide comments as necessary.
Click Continue.

6 Verify your information and click Collect Product Info.
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Posting the SWID File

After the SWID is generated, it is automatically posted to an FTP site (ftp://ftp2.novell.com/partners/
tally/swidwizard/), if you enabled the check box as indicated in Step 4d of the User Information page.
The SWID file along with the bitmap image can also be sent to zam_support@novell.com.

We monitor the FTP site and the zam_support inbox. When we receive a request we send an
acknowledge to the customer mail ID that you provided in the SWID file. (See Step 4b of the User
Information page).

A SWID must be posted before the 20th of the month to be included in the current PRU. Requests
posted after the 20th of the month are included in next month's PRU.

Verifying When New Software Is Included in the PRU

A new PRU is released on the first day of each month. A list of new software that has been
fingerprinted for the month is posted at the FTP site (http://ftp2.novell.com/partners/tally/pru/
TCAIIPrd.txt).

You can also download the latest PRU from ZENworks Control Center. Click the PRU and access the
Readme for <PRU Month Year PRU>.
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7.1

Using Administrator-Defined Fields

The following sections provide information about Novell ZENworks 11 SP3 features and procedures
for administrator-defined fields.

¢ Section 7.1, “About Administrator-Defined Fields,” on page 85

¢ Section 7.2, “Creating an Administrator-Defined Field,” on page 86

¢ Section 7.3, “Removing Administrator-Defined Fields from Web Console Reports,” on page 88

About Administrator-Defined Fields

Administrator-defined fields allow you to add custom fields to inventory data. There are four types
of fields:

¢ User: Used for gathering demographic data about the workstation user through the Collection
Data Form.

+ Workstation: Used for gathering demographic data about the workstation through the
Collection Data Form.

¢ Component: Used for defining inventory data about a component.

¢ Product: Used for defining inventory data about a product.

Figure 7-1 Administrator-Defined Fields Panel

»

Administrator -Defined Fields

Type Fields
User 0
Workstation 0
Camponent 0
Product 0

The Administrator-Defined Fields panel shows the type of field and the number of defined values.
When you create a User or Workstation field, it appears on the Collection Data Form as a field for
workstation users to fill out. Component and Product field values are added to the properties of the
component or product. You can change the field value of an individual component or product by
performing a product or component search, clicking the product or component, and editing the field
value on the Product Details page. For more information, see Chapter 9, “Managing Component
Data,” on page 103 and Chapter 10, “Managing Product Data,” on page 107.
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7.2 Creating an Administrator-Defined Field

Regardless of the type of administrator-defined field you want to create, the steps are the same,
whether it is a User, Workstation, Component, or Product field.
1 In ZENworks Control Center, click Configuration, then click the Asset Inventory tab.

2 In the Administrator-Defined Fields panel, click the type of field you want to create: User,
Workstation, Component, or Product.

hszet Inventory » Administrator-Defined Fields (User)
User Fields &
New
D Hame = Data Type Size Edit Type Default Value Internal Hame

Mo frems available.

The User Fields panel shows existing defined fields, along with the following information:
Name: The name of the field.
Data Type: The data type: character, integer, decimal, or date.
The date format depends on the Zenworks Control Center location that is used.
For instance:
¢ If you login using English, you need to enter date in the MM/DD/YYYY format
¢ If you login using French, you need to enter date in the DD/MM/YYYY format
¢ If you login using Chinese, you need to enter date in the YYYY-MM-DD format
Size: The number of alphanumeric characters. This applies only to character-type fields.
Edit Type: Specifies how the user enters a response. The values are Edit, List, and Combo.
Default Value: The value that is specified when the field is created.
Internal Name: The field’s internal ID.
3 Click New.
New Administator-Defined Field
¥ Step 1: General Information

Enter general field information

Type: User

Name: * | |

Default | |
Value:

Size: %

Fields marked with an asterizk are required.

<< Back | Mest»> | [ Cancel |

4 Fill in the fields:
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Type: Filled in by default depending on the type of field you selected.
Name: Name of the administrator-defined field. This field is required.
Default Value: The default value of the field.

Data Type: Character, Integer, Decimal, or Date. If you choose Date as the data type, then you need
to enter the date in the MM/DD/YYYY format.

Size: The maximum number of alphanumeric characters allowed in the field. This applies only
to character-type fields.

Edit Type: Allows greater flexibility in entering and selecting field values. There are three
options:

+ Edit: Allows the user to enter a value or edit the default value.
¢ List: Allows the user to select a value from a list of possible choices.
* Combo: Allows the user to enter a value or select from a list.

Edit Mask: Select a format from the Edit Mask field list to restrict how a value is entered. The
choices are phone, time, and currency. This applies only to character-type fields.

5 Click Next.

6 If you chose List or Combo as the Edit Type in Step 4 on page 86, specify a list of choice values and
click Next.

New fdministator-Defined Field
&N Step 2: Choice List Values

Enter choice list values for the field

Choice List ¥alues:

| Add
Edit

Remove

Import...

<< Back Mext >> Cancel

6a Specify a value in the Choice List Values field.

6b Click Add. Repeat for additional values.

6c Repeat Step 6a on page 87 and Step 6b on page 87 for additional values.
6

6e (Optional) Select a value and click Remove to remove it.

o

(Optional) Select a value and click Edit to change it.

6f (Optional) Import a list of values by clicking Import and specifying a file in the Import File
field.

7 Click Finish to create the new field.
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7.3 Removing Administrator-Defined Fields from Web Console
Reports

Deleting an administrator-defined field does not remove references from the Web console report
definition. You must remove the references manually.

1 Log in to ZENworks Control Center and select the report to be removed.

2 In the Custom Report Definition Summary page, click Edit.

3 From the Available list in the right panel, click the administrator-defined field to select it.
4 Click 4] to remove the selected administrator-defined field reference.

5 Click Save to save the report definition.
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8.1

8.1.1

Using Reports

Reports allow you to view and analyze inventory data from your Management Zone. ZENworks
Control Center includes predefined reports you can run along with reports you can customize. This
section includes the following topics:

Using Inventory Standard Reports

Standard or predefined reports scan your inventory data and arrange the data according to the report
configuration. More information is available in the following topics:

¢ Section 8.1.1, “Available Standard Reports,” on page 89

¢ Section 8.1.2, “Running a Standard Report,” on page 91

¢ Section 8.1.3, “Inventory Business Objects Enterprise Reports,” on page 92

Available Standard Reports

ZENworks Control Center includes several predefined reports you can use to analyze the inventory
in your Management Zone. These reports are grouped into folders according to their function. The
available folders and reports are as follows:
¢ Device Lists (folder): Reports focusing on device details.
¢ Devices by Machine / Login Name: Lists all devices by machine and login name.
¢ Devices by Mfg / Model: Shows a count of systems by manufacturer and model.
¢ Lease Details: Shows leased devices by contract along with the expiration date.

+ Devices with Virtual Machines: Shows devices with host virtual machines that have been
scanned.

¢ Duplicate Asset Tags: Shows devices with duplicate asset tags.

¢ Duplicate Machine Names: Shows devices with duplicate machine names.

¢ Duplicate Serial Numbers: Shows devices with duplicate serial numbers.
¢ Software Applications (folder): Reports focusing on software applications.

¢ Antivirus Details: Shows antivirus definition files with links to the devices where they are
installed.

¢ Software Applications by Category: Shows a count of installed software products grouped
by category and subcategory.

¢ Software Applications by Manufacturer: Shows a count of installed products grouped by
manufacturer.

¢ Software Applications by OS and Product: Shows a count of installed products grouped
by operating system and product name.
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Duplicate Serial Numbers: Shows software products that have multiple instances of the
same serial number.

High Bandwidth Applications: Shows a count of high-bandwidth products, such as
multimedia and file-sharing software.

Hot Fix Details: Shows hot fixes and security patches with links to descriptions of the fixes
and patches and the machine that they were installed on.

Microsoft Products: Shows a count of installed Microsoft products grouped by
classifications specific to Microsoft.

Operating Systems: Shows a count of devices grouped by the installed operating system.

OS Service Packs: Shows a count of devices grouped by operating system and service
pack.

+ Software Files (folder): Reports focusing on software files, grouping them by category,
manufacturer, and device.

*

*

*

Software Files by Category: Shows a count of software files grouped by category (All,
Other, Ancillary, and System) with links to lists of the files.

Software Files by Manufacturer: Shows a count of software files grouped by manufacturer
with links to lists of the files.

Software Files by Device: Shows a count of software files grouped by device with links to
lists of the files.

¢ Hardware Components (folder): Reports focusing on hardware data.

*

*

*

*

BIOS: Shows installed versions and release dates grouped by manufacturer.

Hardware Components by Category: Shows a count of installed hardware products by
category and subcategory.

Hardware Components by Manufacturer: Shows a count of installed hardware products
grouped by manufacturer.

Disk Space: Shows a count of devices with total disk space within a specific range.
Duplicate Serial Numbers: Shows hardware products with the same serial number.
Free Disk Space: Shows a count of devices with free disk space within specific ranges.
Memory Size: Shows a count of devices grouped by RAM size.

Processors: Shows a count of devices grouped by CPU speed.

¢ Upgrade Readiness (folder): Reports that help you determine which devices are ready for an
upgrade.

*

*

Memory Upgrade: Lists devices along with data on memory and available slots.

SLED 10 Ready / Not Vista Capable: Shows devices ready for SUSE Linux Enterprise
Desktop 10 that are not ready for Windows Vista.

SLED 10 Ready / Not Vista Premium Ready: Shows devices ready for SUSE Linux
Enterprise Desktop 10 that are not ready for Windows Vista Premium.

SUSE Enterprise Desktop: Lists devices along with data showing whether the device is
ready or not ready for SUSE Linux Enterprise Desktop.

Windows 2003 Server: Lists devices along with data showing whether the device is ready
or not ready for Windows Server 2003.

Windows Vista Capable: Shows devices capable of running Windows Vista.

Windows Vista Premium Ready: Shows devices capable of running Windows Vista
Premium.
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+ Windows XP Professional: Shows devices along with data showing whether the device is
ready or not ready for Windows XP Professional.

8.1.2 Running a Standard Report

1 In ZENworks Control Center, click Reports.

Inventory Standard Reports

DR DRE

Group

Device Lists

software Applications
Software Files
Hardware Components
Upgrade Readiness

»

2 In the Inventory Standard Reports panel, click the folder containing the report you want to run.

Re

ports
Hame
Antivirus Details

software Applications By Category

software Applications By Manufacturer

Software Applications By 05 and Produck

Duplicate Serial Mumbers
High Bandwidth Applications
Hot Fix Details

ticrosoft Products

=] Operating Systerns

05 Service Packs

Description

Antivirus definition files with links to devices where installed

Count of installed software products by category and subcategory

Count of installed software products by manufacturer

Count of installed software products by product name

Lists software products installed with multiple instances of the same serial number
Count of popular multimedia and file-sharing apps such as KaZaa and Gnutella

Hot fixes and security patches with links to list of devices where installed

Count of installed Microsoft products grouped by Microsoft-specific classifications
Count of devices by installed operating system

Count of devices by installed operating systern and service pack

Reports are listed by name and description. For a list of reports and descriptions, see
Section 8.1.1, “Available Standard Reports,” on page 89.

3 (Optional) Select how you want to filter your search.

Grouping Criteria

@ zone
C Folder
OGroup

C pemographic

You can limit the scope of the report data by any of the following;:

*

*

*

*

Zone: Select Zone to collect data from the entire Management Zone.

Folder: Select Folder and specify a folder name to gather data about that folder.

Group: Select Group and specify a group name to gather data about that group.

Demographic: Select Demographic, then select the criteria you want to use to filter the data.

4 Click a report to run it.

Click the various links on the report for additional information. You can export the report to an
Excel, CSV, or PDF format by clicking the corresponding link. In some reports, you can also click
Graph to view the data in a bar graph, pie chart, or line graph format.
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8.1.3

8.2

8.2.1

Inventory Business Objects Enterprise Reports

ZENworks Control Center allows you to create and run an Inventory Business Objects Enterprise
report that describes the green attributes of inventoried devices in the Management Zone.

Device AC Power Policy: This report provides details on the AC power management settings for
policy compliance in each of the devices in a zone.

The report also provides a graphical representation of the number of devices in a zone that are
complying or not complying with the green standards.

Power Compliance: This report provides details on the compliance of the devices in the zone with
respect to hardware capabilities and power management needed for green computing.

This report has two sections:
1. Hardware Capability: Details the hardware capabilities of all the devices in the zone with
respect to green computing and compliance of each of the devices with the green standards.

2. Time Since Boot: Details the power management activity of the devices in the zone. The section
also highlights the devices that have been switched on for long periods of time (24 hours), which
means they do not conform to the green standards.

Using Inventory Custom Reports

ZENworks Control Center allows you to create and run custom reports that you can use to analyze
the inventory in your Management Zone. These sections provide more information:

¢ Section 8.2.1, “Available Custom Reports,” on page 92

¢ Section 8.2.2, “Running a Custom Report,” on page 94

¢ Section 8.2.3, “Creating a Custom Report,” on page 94

¢ Section 8.2.4, “Scheduling a Custom Report and Sending Notifications,” on page 96

¢ Section 8.2.5, “Configuring E-mail Addresses,” on page 97

¢ Section 8.2.6, “Editing a Custom Report,” on page 98

¢ Section 8.2.7, “Moving a Custom Report,” on page 99

¢ Section 8.2.8, “Deleting a Custom Report or Folder,” on page 100

¢ Section 8.2.9, “Viewing Scheduled Reports by Date and Title,” on page 100

¢ Section 8.2.10, “Importing New Report Definitions,” on page 101

Available Custom Reports

ZENworks Control Center includes several predefined reports you can use to analyze the inventory
in your Management Zone. These reports are grouped into folders according to their function. The
available folders and reports are as follows:

¢+ Hardware Components (folder): Reports focusing on hardware components, such as BIOS and
system details.
¢ BIOS and System Details: Shows the BIOS details for all current systems.

¢ Hardware added or deleted in last 6 months: Lists the hardware components in the
Management Zone and shows the number of additions and deletions over the previous 6
months.
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¢ USB devices added in last 30 days: Shows the workstations that have had a USB device
added in the previous 30 days.

+ Workstations with memory deletions in last 30 days: Shows the workstations that have
had memory module deletions during the previous 30 days.

¢ Local Product Creation (folder): Reports focusing on software files that can be used to create
Local Software Products. For more information on Local Software Products, see Chapter 6,
“Creating Local Software Products,” on page 73.

WARNING: If you rename, move or delete the Local Product Creation folder or its contents,
you will not be able to create the Local Software Products.

¢ Software Files by Machine: Shows the software files on each machine. You can use this
report to create Local Software Products.

¢ Unique Software Files: Shows the software files along with Version Resource Block (VRB)
data. You can use this report to create Local Software Products.

+ Software Applications (folder): Reports focusing on software applications, such as how many
applications were added during a specified time.

¢+ SW apps added in last 30 days (by product): Shows the software applications that were
added during the previous 30 days, grouped by product.

¢+ SW apps added in last 30 days (by workstation): Shows the software applications that
were added during the previous 30 days, grouped by workstation.

¢ SW apps deleted in last 30 days (by product): Shows the software applications that were
deleted during the previous 30 days, grouped by product.

¢+ SW apps deleted in last 30 days (by workstation): Shows the software applications that
were deleted during the previous 30 days, grouped by workstation.

+ Workstations with antivirus software: Shows the Windows workstations (not marked as
deleted) with antivirus software installed.

+ Workstations with suspicious software installed: Shows the workstations with suspicious
software installed.

+ Workstations without antivirus software: Shows the Windows workstations (not marked
as deleted) without antivirus software installed.

¢ Systems (folder): Reports focusing on system details, such as how many systems were added
during a specified time.

¢ Hosts of Virtual Machines: Shows the systems that are hosting virtual machines.

¢ Systems added in last 90 days: Shows the systems (Windows, UNIX/Linux) that were
added to the inventory database during the last 90 days.

¢ Systems deleted in last 90 days: Shows the systems (Windows, UNIX/Linux) that were
deleted during the previous 90 days.

¢ Systems that have not loaded results in 90 days: Shows the systems (Windows, UNIX/
Linux) that have not been marked as deleted and have not loaded scan results during the
previous 90 days.

¢ Systems with less that 100 MB free space: Shows the systems (Windows, UNIX/Linux)
that have not been deleted and have less than 100MB free disk space.

¢ Systems with less that 128 MB memory: Shows the systems (Windows, UNIX/Linux) that
have not been deleted and have less than 128MB total memory.

¢ Virtual Machines: Shows the virtual machines in your Management Zone.
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8.2.2 Running a Custom Report

1 In ZENworks Control Center, click Reports.
2 In the Inventory Custom Reports panel, click the folder containing the report you want to run.

The number of reports in each folder is shown in the Report Count column.

Custom Reports

|:| Title = Type Focus Create Date Last Run
[0 El Hardware added or delsted in last 6 months Hardware Cormponents History Jul 2, 2007
[ &l usk devices added in last 30 days Hardware Corponents Removable Media Jul 2, 2007

[ & wiorkstatinns with mermaory deletions in last 30 days Hardware Camponents sermorg sodule .l 2, 2007

<|b|1—30f3 show 10 + items

3 Click a report.

Custom Report Definition Summary: Hardware added or deleted in last 6 months

Description Lists hardware components with number of
additions and deletions in last & months

Type Hardware Components, focusing on History

Columns Product ihanufacturer
Product Mame
Mews Products (Summary)
Deleted Products (Summary]

Criteria Product Creation Date within six months before
Report Date or
Product Deletion Date within six months before
Report Date

Creator

Creation Date T2y
Last Run Date

Bun Schedule/Notification Edit Copy

4 Click Run in the lower left corner.

On the report page, click the various links on the report for additional information. You can
export the report to an Excel, CSV, or PDF format by clicking the corresponding link.

8.2.3 Creating a Custom Report

1 In ZENworks Control Center, click Reports.

2 In the Inventory Custom Reports panel, click the folder where you want to save the report, or
create a new folder by clicking New, specifying a folder name, then clicking OK.

3 Click New.
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Custom Report Definition - $tep 1 of 2: Choose Type and Focus

Hame

Type

Focus

@Devices

OSoftware Applications
() Software Fles
OHardware Components

() Licenze Management

(&) Basic Device Attributes
OProduct Filtering

() File Filkering
OHistory

Continue... |

Cancel |

4 Specify a name in the Name field.

5 Select the report type. The types are:

* Devices

¢ Software Applications

*

Software Files

*

¢ License Management

Hardware Components

6 Select the focus of the report. The options are:

* Basic Device Attributes

*

Product Filtering

*

File Filtering
+ History
7 Click Continue.

Custom Report Definition - Step 2 of 2: Choose columns, column order, and criteria

Hame Report 1 Description

Folder Hardware Components

Type Devices

Columns Awailable Auailable

Asset Tag (Device)
Awailable Memory Slots
Building

CPU Product

CPU Speed [MMHz)

Cost Center

Department

Device Create Date
Device Date Last Modified
Device Deletion Date

Machine Name

v
Criteria Field Operator Walue
Device I= Deleted = Mo
Summary Criteria Summary Feld Cperator Value
Back Save Cancel

Column Order

A
=

EEH
N
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8 Fill in the following fields:
Name: Specify the name of the report.
Folder: Select a folder where you want to save the report.
Description: Specify a description for your report.
Type: This field is display only. It shows the report type you selected.

Columns: From the list on the left, select what data you want to include in your report. Use the
arrow icons to move the selected data to the list on the right. Use Ctrl+click to select more than
one option at a time. Use the up and down icons to arrange how you want the data displayed.

Criteria: Select your filter criteria in the Field, Operator, and Value fields. Use the +icons to add
filters; click the - icon to delete a filter. Click OR or AND to toggle back and forth between the
two operators.

Summary Criteria: Select your summary filter criteria in the Field, Operator, and Value fields. Use
the + icons to add filters; click the - icon to delete a filter. Click OR or AND to toggle back and
forth between the two operators

9 Click Save.

8.2.4  Scheduling a Custom Report and Sending Notifications

You can schedule a report to run automatically and send out notifications to specified people when
the report is ready. To schedule a report and configure notifications:

1 In ZENworks Control Center, click Reports.

2 In the Inventory Custom Reports panel, click the folder containing the report you want to
schedule.

3 C(lick the report you want to schedule.

Custom Report Definition Summary: Hardware added or deleted in last 6 months

Description Lists hardware components with number of
additions and deletions in last & months

Type Hardware Components, focusing on History

Columns Product Manufacturer
Product Mame
Mews Products (Summary)
Deleted Products (Summary]

Criteria Product Creation Date within six months before
Report Date or
Product Deletion Date within six months before
Report Date

Creator

Creation Date Fr2y

Last Run Date

RBun Schedule/Notification Edit Copy

4 Click Schedule/Notification.
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8.2.5

Schedule Report/Motification:  Workstations with memory deletions in last 30 days

Start Date
Frequency Yeatly W
Output ® Stored Report Results

OSend a Motification [E-mail)
(O Both

[¥]5end notification / Store results, only when matching records are found

Maximum Records

Submit | Cancel |

5 Fill in the following fields:
Start Date: Click the calendar icon to specify a date.

Frequency: Select how often you want to send the notification: yearly, monthly, weekly, daily,
once, or never.

Output: Select whether you want to store the report, send an e-mail notification that the report is
ready, or both. You can also choose to store the results or send a notification only when matching

records are found. For information on configuring e-mail addresses, see Section 8.2.5,
“Configuring E-mail Addresses,” on page 97.

Maximum Records: Specify the maximum number of records to store.
6 Click Submit.

Configuring E-mail Addresses

You can send notifications to selected people when a custom report is run. To do this, you need to
import the e-mail addresses of those you want to notify into ZENworks Control Center. For
information on sending notifications, see Section 8.2.4, “Scheduling a Custom Report and Sending
Notifications,” on page 96.

The E-mail Addresses panel on the Configuration page allows you to import e-mail addresses that
can be used to send notifications when a custom report is ready, as configured in the report
definition. Previously imported e-mail addresses are listed in the panel, along with the user’s first,
last, and middle name.

To import e-mail addresses:

1 In ZENworks Control Center, click Configuration.
2 Click the Asset Inventory tab.
3 In the E-mail Addresses Panel, click Action > Manage E-mail Addresses.

Manage E-mail Addresses

Import From Inventary Data v

nwventory Data
Comma Separated File

Import Cancel Delete...

4 In the Import From field, select either Inventory Data or Comma Separated File.
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If you select Inventory Data, the e-mail addresses found in an inventory scan will be imported. If
you select Comma Separated File, specify the file location in the E-mail Address File field. Use the
first name,middle name, last name,email address format to save the CSV file.

For example, if the name is Wen Zeng Hong and the email address is wzh@gmail.com, specify
the file location as Wen, Zeng, Hong, wzh@egmail .com. If there is no middle name, Zeng, save the
CSV file as Wen, ,Hong, wzh@gmail . com.

5 Click Import.
6 Click Close.

To delete all e-mail information:

1 In ZENworks Control Center, click Configuration.

2 In the E-mail Addresses Panel, click Action > Manage E-mail Addresses.

3 Click Delete.

4 Click OK.

All e-mail information is deleted.

8.2.6  Editing a Custom Report

1 In ZENworks Control Center, click Reports.

2 In the Inventory Custom Reports panel, click the folder containing the report you want to edit.

3 Click the report.

Custom Report Definition Summary: Hardware added or deleted in last 6 months

Description

Type

Columns

Criteria

Creator

Creation Date

Last Run Date

Lists hardware components with number of
additions and deletions in last & months

Hardware Components, focusing on  History

Product Manufacturer
Product Mame

MNew Products (Summary]
Deleted Products (Summary)

Product Creation Date within six months before
Report Date or

Product Deletion Date within six months before
Report Date

Fr2nr

Bun Schedule/Notification Edit Copy

4 Click Edit in the lower left corner.
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Custom Report Definition

Hame Wiorkstations without antivirus softwars Description |i5ts purrent Windows workstations [net marked s

ibased on dependent repart]

Folder Software Applications v
Type Software Applications, focusing on General Software
Columns hwailable Awailable Column Order
Additional SW Info L) fhachine MName
Ayailable Memary Slots Serial Number (Dewice)
Building. hsset Tag (Device]
CPU Product IP Address
CPU Speed (iiHz) lz”ﬂ' 05 Product E|
Cost Center EE 05 model lz‘
Current fManufacturer Login Name
Device Create Date Department
Device Date Last Modified
Dewice Deletion Date ~
Criteria Field Operatar Value
Device & Deleted v = Ho v awp =
Product Is Deleted v - Ho v AND =
DevicaQWERTY v not in report AND =
Invntory Type v =
Summary Criteria Summary Feld Operatar Walue

Save Cancel

5 Edit the following fields:
Name: The name of the report.
Folder: The folder where you want to save the report.
Description: The description for your report.
Type: This field is display only. It shows the report type you selected.

Columns: From the list on the left, select what data you want to include in your report. Use the
arrow icons to move the highlighted data selection to the list on the right. Use Ctrl-click to select

more than one option at a time. Use the up and down icons to arrange how you want the data
displayed.

Criteria: Select your filter criteria in the Field, Operator, and Value fields. Use the + icons to add

filters; click the - icon to delete a filter. Click OR or AND to toggle back and forth between the
two operators.

Summary Criteria: Select your summary filter criteria in the Field, Operator, and Value fields. Use
the +icons to add filters; click the - icon to delete a filter. Click OR or AND to toggle back and
forth between the two operators.

6 Click Save.

8.2.7 Moving a Custom Report

1 In ZENworks Control Center, click Reports.

2 In the Inventory Custom Reports panel, click the folder containing the report or reports you
want to move.

3 Select the report or reports you want to move.
4 Click Edit > Move.
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Move Report(s) to New Folder

Mew Report Location
‘ Hardware Components v

OK Cancel

5 Select a new folder location.
6 Click OK.

WARNING: If you move reports in the Local Product Creation folder, you will not be able to
create the Local Software Products.

8.2.8  Deleting a Custom Report or Folder

To delete a custom report:
1 In ZENworks Control Center, click Reports.
2 In the Inventory Custom Reports panel, click the folder containing the report you want to delete.
3 Select the report you want to delete.
4 Click Delete.
To delete a folder:

1 In ZENworks Control Center, click Reports.
2 In the Inventory Custom Reports panel, select the folder you want to delete.
3 Click Delete.

WARNING:

¢ If you delete reports in the Local Product Creation folder, you will not be able to create the
Local Software Products.

¢ Deleting a folder deletes all the reports in that folder.

8.2.9 Viewing Scheduled Reports by Date and Title

Reports that are run on a schedule are stored in a database. You can view these reports either by title
or date. For information on scheduling reports, see Section 8.2.4, “Scheduling a Custom Report and
Sending Notifications,” on page 96.

To view a scheduled report by date or title:

1 In ZENworks Control Center, click Reports.

2 In the Inventory Custom Reports panel, click one of the following:
¢ Action > View Scheduled Report Results by Date
¢ Action > View Scheduled Report Results by Title
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The Scheduled Reports by Grouping page opens and shows the saved scheduled custom reports
grouped by date or title and a report count. Click the date or title to open the Scheduled Reports
page, where you can select a report and view it. To delete a group of reports, select the group

and click Delete.

Scheduled Reports

|:| Results = User Hame Records $torage Size (KB)
Q 4

show 10 = items

[ Bl workstations with memory deletions in last 30 days
4 r[1-10r1

8.2.10 Importing New Report Definitions

If you have defined reports in ZENworks Asset Management 7.5, you can import them into
ZENworks Control Center. You can also re-import reports that have been exported by ZENworks
Control Center. A predefined XML format is needed for import.

To import report definitions:

1 In ZENworks Control Center, click Reports.
2 In the Inventory Custom Reports panel, click Action > Import New Report Definition.

Import Custom Report Definition

Query import file:
Impaort | Cancel |

3 Specity the file in the Query import file field, or click Browse to search.
4 Click Import.

8.3 Inventory Report Rights

Inventory Report Rights allows you to manage the administrator rights for each folder and its
reports. Each report folder has rights associated with it, governing all the reports within that folder.
For example, if you have full rights, you can edit a report; but with view/execute rights, you can only
see the report and run it. With inventory report rights, you can limit who has access to certain reports
and who has permission to edit them. The report folder type, custom or standard, and the report
name are listed along with the rights associated with the folder. The choices are:

¢ Remove all rights: This removes all rights to the folder, so the specified administrator cannot
see it.

¢ Assign view/execute rights: This allows the specified administrator to view and execute a
report in the specified folder, but not to edit, move, or delete a report in that folder.

¢ Assign full rights: This gives the specified administrator full rights to create, edit, move, and
delete reports. For standard reports, this setting is the same as View/Execute, because you cannot

alter a standard report.
To change inventory report rights:

1 In ZENworks Control Center, click Configuration.
2 In the Administrators panel, click an administrator.

3 Click on the Rights tab.
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Inventory Report Rights

Folder Type =

Custom Reports
Custom Reports
Custom Reports

Custom Reparts

Standard Reports
Standard Reports
Standard Reports
Standard Reports

Folder Hame

Local Product Creation
Systems

Hardware Components
Software Applications
Device Lists

Software Applications
Software Files
Hardware Components

Upgrade Readiness

Rights

Wiew Execute Rights
Wiews Execute Rights
Wiew Execute Rights
Wiews Execute Rights
Wiews Execute Rights
Wiews Execute Rights
Wiews Execute Rights
Wiews Execute Rights
Wiew/ Execute Rights

4 In the Administrator Tasks panel on the left, click Inventory Report Rights.

»

O
O
O
O
O
[ standard Reports
O
O
O
O
]

b [1-90f9 show 20 ¥ ftems

5 Select the desired folders.
6 Click one of the following:
¢ Edit > Remove All Rights
¢ Edit > Assign View/Execute Rights
¢ Edit > Assign Full Rights
The change is reflected in the Rights column.

8.4 Administrator Rights

Administrators now have access to change or assign the report rights. The Inventory Report Rights
page allows you to configure the default rights settings that you can assign to a user. By default, a
user has View/Execute Rights enabled. Changing this setting does not affect existing users whose
default rights were already modified.

You can use either of the following settings as the default:

+ No Rights
¢ View/Execute Rights
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9.1

Managing Component Data

A component is a hardware or software product associated with a workstation, for example, a
spreadsheet application or a network interface card. ZENworks Control Center allows you to list a
workstation’s components or find workstations with a particular component. After you locate the

component, you can edit the component data, such as the product name and serial number. You can
examine component data through component searches.

The following sections provide information about managing component data:

¢ Section 9.1, “Searching for a Component and Viewing Component Data,” on page 103
¢ Section 9.2, “Editing the Component Data,” on page 104

Searching for a Component and Viewing Component Data

Before you can view component data, you need to perform a component search. Component searches
are done through the Component Search panel (Configuration > Asset Inventory).

Figure 9-1 Component Search Panel

Component Search

»

Define filter criteria to search for components:

Machine Name Manufacturer Product = Version Category Subcategory

Ne items available.

The Component Search panel allows you to select filters and filter sets to search for a particular
component, then lists the components along with the following information:

¢ Machine Name: The name of the machine that has the particular product.
¢ Manufacturer: The manufacturer of the product.

¢ Product: The name of the product.

¢ Version: The version of the product.

¢ Category: The product category.

¢ Subcategory: The product subcategory.
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To search for a component and view component data:

1 In ZENworks Control Center, click Configuration, then click the Asset Inventory tab.

2 In the Component Search panel, click Add Filter or Add Filter Set, depending on the filtering
model you want to use.

»

Component Search

Define filter criteria to search for components:

Combine Filters using: i and |

O| R H ~-Select- :_i

| Search |

Machine Hame Manufacturer Product = Version Category Subcategory

No items available.

3 Select options for your filter.

For example, you could search by machine name or department.
4 (Optional) Create additional filters or filter sets.
5 Click Search.

Components matching your search criteria are listed, along with additional information about
the component.

9.2 Editing the Component Data

1 Search for a component, as shown in Section 9.1, “Searching for a Component and Viewing
Component Data,” on page 103.

2 Click a product name to view the component details. To add new hardware or edit the serial
number or asset tag of existing hardware, log in to the Inventory Collection Editor as an
administrator from your managed device. For more information, see “Working with the
Inventory Collection Editor” in the Novell ZENworks11 Adaptive Agent Guide.

The Component Details panel opens, displaying the following details about the component,
along with any administrator-defined fields:

¢ Machine Name: The name of the machine.
¢ Product: The name of the product.
¢ Asset Tag: The asset tag number.

¢ Serial Number: The component’s serial number.

»

Component Details

Machine Name: IZENDOCWKST
Product: [101/102 keyboard [Change Product |
Asset Tag: | ‘

Serial Number: | |
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3 Click Change Product to open the Product Search window, where you can search for and select a
new product name.

Product Search

Define filter criteria to search for products:

Add Filter Add Filter Set

Select Product

|:| Manufacturer Product = VYersion Category Subcategory

Mo items available.

Select your filter criteria, then click Search.

Select a product from the list, then click Select Product.
Edit the other fields as desired.

Click OK or Apply.

~N o o b~

9.2.1 Using Administrator-Defined Fields

You can add administrator-defined fields to the Component Details panel to show additional
information about the component. For example, you could add a field called Malfunctioning, with a
Yes or No choice selection to show the product’s working status. For more information on creating
administrator-defined fields, see Chapter 7, “Using Administrator-Defined Fields,” on page 85.
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10.1

Managing Product Data

A product is a piece of hardware or software identified by the manufacturer, product name, and
model/version. ZENworks Control Center allows you to search for products, view details about the

product, and classify products according to category and subcategory. The following sections
provide more information about managing product data:

¢ Section 10.1, “Searching for a Product and Viewing Product Data,” on page 107
¢ Section 10.2, “Reclassifying a Product,” on page 108

¢ Section 10.3, “Managing Product Categories and Subcategories,” on page 109

Searching for a Product and Viewing Product Data

Before you can view product data, you need to perform a product search. Product searches are done
through the Product Search panel (Configuration > Asset Inventory).

Figure 10-1 Product Search Panel

Product Search

»

Define filter criteria to search for products:

Manufacturer Product = Version Category Subcategory

o items available.

The Product Search panel allows you to select filters and filter sets to search for a particular product,
then lists the product along with the following information:

¢ Manufacturer: The manufacturer of the product.
¢ Product: The name of the product.

¢ Version: The version of the product.

¢ Category: The product category.

¢ Subcategory: The product subcategory.

To search for a product and view product data:

1 In ZENworks Control Center, click Configuration, then click the Asset Inventory tab.

2 In the Product Search panel, click Add Filter or Add Filter Set, depending on the filtering model
you want to use.
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Product Search

»

Define filter criteria to search for products:

Add Filter Add Filter Set
Combine Filters using: | and *

| ‘ hd || ~Select- b ‘

[ Searsh |

Manufacturer Product a Version Category Subcategory
No items available.

3 Select options for your filter.

For example, you could search by product category or type.

4 (Optional) Create additional filters or filter sets.
5 Click Search.

Products matching your search criteria are listed, along with additional information about the

product.

10.2 Reclassifying a Product

108

Products are classified by category and subcategory. To change product classification:

1 Search for a product as shown in Section 10.1, “Searching for a Product and Viewing Product

Data,” on page 107.

2 Click a product name to open the Product Details panel.

Product Details

»

Manufacturer: |Macrovisioﬂ

Product: IAdminStudio

Version: IS

Category/Subcategory: | AssetMgmt/ Other e

3 In the Category/Subcategory field, select a new category/subcategory pair.

For added flexibility, ZENworks Control Center allows you to create new category/subcategory
pairs. For more information, see Section 10.3, “Managing Product Categories and

Subcategories,” on page 109.

4 Click OK or Apply.
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10.3 Managing Product Categories and Subcategories

During an inventory scan, ZENworks Control Center uses a knowledgebase of thousands of
products to identify scanned products. After they are identified, these products are classified by
category and subcategory. For added flexibility, ZENworks Control Center allows you to reclassify
products and create new product categories.

Categories and subcategories are managed through the Product Categories panel (Configuration >
Asset Inventory). This panel displays the following information:

¢ Category Type: The product category, such as CPU or CD-ROM. These are predefined.

¢ Category Name: The name of the product category.

¢ Source: Specifies whether the category name is a default value (Novell) or a user-defined value
(Local). Only Local categories can be edited or deleted.

Figure 10-2 Product Categories Panel

B

Product Categories

|:| Category Type & Category Hame Source
O Blos BIOS Movell
[ coRom CD/DVD Movell
[ corem CD/DYD Reader Movell
[ CDRom CD/DYD Burner Hovell
O cpu Processar Hovell
«[p[1-50r71 show 5v items

The following sections provide more information about managing product categories and
subcategories:

¢ Section 10.3.1, “Creating a New Product Category,” on page 109

¢ Section 10.3.2, “Renaming a Product Category,” on page 110

¢ Section 10.3.3, “Deleting a Product Category,” on page 110

¢ Section 10.3.4, “Creating a New Product Subcategory,” on page 110

¢ Section 10.3.5, “Renaming a Product Subcategory,” on page 111

¢ Section 10.3.6, “Deleting a Product Subcategory,” on page 111

10.3.1 Creating a New Product Category

1 In ZENworks Control Center, click Configuration, then click the Asset Inventory tab.
2 In the Product Categories panel, click New.

New Product Category

Category Type
|BloS ~||

Categary Name

[ ok | [ Cancel |

3 Select a category type in the Category Type field.
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10.3.2

10.3.3

4 Specify a name in the Category Name field.
5 Click OK.

The new category is added to the category list with the source shown as Local. You can further
define this category by assigning a subcategory. For more information, see Section 10.3.4,
“Creating a New Product Subcategory,” on page 110.

Renaming a Product Category

1 In ZENworks Control Center, click Configuration, then click the Asset Inventory tab.
2 In the Product Categories panel, select the category you want to rename.

You can only rename categories whose source is Local.
3 Click Edit > Rename.

Category Name

lacmE]

[ ok | [ Cancal |

4 Specify a new name in the Category Name field.
5 Click OK.

Deleting a Product Category

1 In ZENworks Control Center, click Configuration, then click the Asset Inventory tab.
2 In the Product Categories panel, select the category you want to delete.

You can only delete categories whose source is Local.
3 Click Delete.

10.3.4  Creating a New Product Subcategory

110

Creating a subcategory further classifies a product.

1 In ZENworks Control Center, click Configuration, then click the Asset Inventory tab.
2 In the Product Categories panel, select a category that you want to create a subcategory for.

3 Click Action > Manage Subcategories.

The Product Subcategories panel appears, listing any predefined subcategories for the specified
category, and the subcategory source, Local or Novell.

Product Subcategories #
|:| Category Hame = Subcategory Hame Source

No items available.

4 Click New.
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5 Specify a name in the Subcategory Name field.
6 Click OK.

10.3.5 Renaming a Product Subcategory

1 In ZENworks Control Center, click Configuration, then click the Asset Inventory tab.

N

In the Product Categories panel, select the category whose subcategory you want to rename.
You can only rename subcategories whose source is Local.

Click Action > Manage Subcategories.

Select the category/subcategory pair.

Click Edit > Rename.

Specify a new name in the Subcategory Name field.

Click OK.

~N o o0 b~ W

10.3.6  Deleting a Product Subcategory

1 In ZENworks Control Center, click Configuration, then click the Asset Inventory tab.

2 In the Product Categories panel, select the category whose subcategory you want to delete.
You can only delete subcategories whose source is Local.

3 Click Action > Manage Subcategories.

4 Select the category/subcategory pair you want to delete.

5 Click Delete.
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Purge Inventory History

The obsolete inventory records can be deleted from the database.This process of deleting the
inventory data is called purging the inventory history. In ZENworks Control Center, you can use the
Purge Inventory History option available under inventory settings to purge the inventory records
after a specific period of time.

In this section you will find information on the following:

¢ Section 11.1, “Configuring Inventory History Purge Settings for the Zone,” on page 113
¢ Section 11.2, “Overriding Inventory History Purge Settings at the Device Level,” on page 115

Configuring Inventory History Purge Settings for the Zone

The Purge Inventory History panel allows you to configure settings to delete the inventory history
and the usage data. You can remove records from the database for the products and components that
were previously marked for deletion and you can also delete software application usage data,
network software usage data, and Web application usage data that is older than the value you set. By
default, all the data is stored in the database unless this setting is configured. Purge schedule of the
Zone is applicable to the devices as well.
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Configuration » Purge Inventory History 88 -

Purge Inventory History x

Configure the inventory history purge settings to remove the inventory history and application usage data.

Purge History Settings A
Specify the interval to purge the data

Remove the deleted products and components older than | 180 day(s)
Remove the inventory history data older than 180 | day(s)

Remove the Software Application Usage data older than | 180 | day(s)

Remove the Netviork Softvare Usage data older than 180 | day(s)
Remove the Web Application Usage data older than 180 | day(s)
Purge History Schedule R

Specify the schedule to run the inventory data purge.

Schedule Type:
Recurring hd

9/ Days of the week

Sun Mon Tue Wed Thu Fri Sat

Start Time: 22 ~ : 00 ~

Duration of the job in hours/run 6

Dedicated Server to run Inventory Pruning

A W N P

@[

OK Cancel

In ZENworks Control Center, click the Configuration tab.
Click Inventory under Management Zone Settings.

Click Purge Inventory History.

Specify the following purge history settings:

¢ Remove the deleted products and components older than x day(s): Specify the number of
days after which to purge the deleted product and component data. The default value is 180
days.

+ Remove the inventory history data older than x day(s): Specify the number of days after
which to purge the inventory history. The default value is 180 days.

¢ Remove the Software Application Usage data older than x day(s): Specify the number of
days after which to purge the software application usage data. The default value is 180
days.

¢ Remove the Network Software Usage data older than x day(s): Specify the number of
days after which to purge the network software usage data. The default value is 180 days.

¢+ Remove the Web Application Usage data older than x day(s): Specify the number of days
after which to purge the Web application usage data. The default value is 180 days.

For example:
If you enter 190 days as the value, all data older than 190 days is deleted.
Specify one of the following as the schedule for purging the history:

¢ Select Recurring to set a schedule that enables the purging process to start at the specified
time of the given day.

¢ Select Noschedule if you do not want to purge the inventory data automatically.

Use the Duration of the job in hours / run option to specify the total duration in number of hours
per run for the purging process
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11.2

7 In the Dedicated Server to run Inventory Pruning field, browse for and select a Primary Server,
then click OK. Pruning takes place on the chosen primary server. If you do not select any, then
pruning takes place on any server.

8 Click Apply or OK to save your settings. Click Reset to return to the default values.

Overriding Inventory History Purge Settings at the Device
Level

You can configure inventory history purge settings for the selected device or server. These settings
allow you to remove the inventory history and application usage data as necessary.

The Purge Inventory History panel allows you to configure settings to remove the inventory history
and the usage data. You can remove records from the database for the products and components that
were previously marked for deletion and you can also delete software application usage data,
network software usage data, and Web application usage data that is older than the value you set. By
default, all the data is stored in the database unless this setting is configured. Device level purging is
based on the Zone level purging schedule.

Devices » Servers > wgp-sitéd > Purge Inventory History &2 -

R wgp-site4

Purge Inventory History x
Configure the inventory history purge settings to remove the inventory history and application usage data,

Current: [System] (Cwerride settings)

»

Purge History Settings
specify the interval to purge the data

[t80 dayis)
[l80 dayls)
[0 dayis)
[i20 " dayis)
[en dayis)

Close

1 In ZENworks Control Center, click the Devices tab.
2 Click Servers or Workstations.

If you are configuring the purge inventory history settings on a device folder or a device, you
need to click Override Settings before you can change the system settings.

3 C(lick a server name or a device name.
4 On the Settings page, click Purge Inventory History.
5 Specify the following purge history settings:

¢ Remove the deleted products and components older than x day(s): Specify the number of
days after which to purge the deleted product and component data. The default value is 180
days.

+ Remove the inventory history data older than x day(s): Specify the number of days after
which to purge the inventory history. The default value is 180 days.

¢ Remove the Software Application Usage data older than x day(s): Specify the number of
days after which to purge the software application usage data. The default value is 180
days.
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¢ Remove the Network Software Usage data older than x day(s): Specify the number of
days after which to purge the network software usage data. The default value is 180 days.

¢+ Remove the Web Application Usage data older than x day(s): Specify the number of days
after which to purge the Web application usage data. The default value is 180 days.

For example:
If you enter 190 days as the value, all data older than 190 days is deleted.
6 Click Apply or OK to save your settings. Click Reset to return to the default values.
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A.l

A.2

Inventory Workflow

*

Section A.1, “Inventory Workflow on a Workstation,” on page 117

*

Section A.2, “Inventory Workflow on a Primary Server,” on page 117

*

Section A.3, “Inventory Workflow on an Inventory Only Device,” on page 118

¢ Section A 4, “Troubleshooting the Inventory Workflow,” on page 118

Inventory Workflow on a Workstation

For any scheduled inventory scan or user-initiated inventory scan, the collector performs the
inventory scan and prepares the scanned file according to the collected data. The workstation then
sends the file to the Collection Server which in turn forwards that file to the Primary Server for
further processing. Only when Collection Servers are not available, the file is sent directly to the
Primary Server for processing.

The collector places the following files:

workstationguid-delta.xml

workstationguid-last.xml

workstationguid-full.xml

in one of the following folders in the workstation:

On Linux devices: /var/opt/novell/zenworks/work/inventory

On Windows devices: <Install -paths\ZENworks\work\inventory

The workstationguid-delta.xml file displays only the current scan excluding the last scan. The
workstationguid-last.xml file contains data related only to the current scan and the
workstationguid-full.xml file includes complete details of all the scans so far.

The collector uploads only the delta file to the ZCM server while the other two files remain on the
device and get updated during the next scan.

Inventory Workflow on a Primary Server

The Inventory Storer that is attached to the loader service wakes up every 30 seconds and checks one
of the following folders:

For Windows Primary Server: <Installed Path>ZENworks\work\collection\inventory

For Linux Primary Server: /var/opt/novell/zenworks/collection/inventory
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A4

The Storer then picks up all the files in one of the above listed folders, which are saved as
<timestamp>-<device guid>-delta.zip files. The Inventory Storer loads all the zipped files
present in the folder, unzips the files, and sorts the files according to the time stamp per device. The
unzipped files are stored in an XML format as <timestamp>-<device guid>-delta.xml.

The Inventory Storer then begins processing each file by creating a WIF object out of the extracted
XML files. After the processing is complete, the data is moved to the database as part of processing of
the WIF XML for that device. After the WIF processing is complete, the XML file is moved to either a
success or failure folder under one of the following folders:

For Windows Primary Server: <Installed Path>ZENworks\work\collection\inventory
For Linux Primary Server: /var/opt/novell/zenworks/collection/inventory

The XML file is moved according to the errors caused by XML formats/database insert/update/
delete issues that occurred during processing.

Inventory Workflow on an Inventory Only Device

For any scheduled inventory scan or user-initiated inventory scan, the Inventory-Only Agent device
sends the file to only the Primary Server for processing. Collection Servers are not supported by
Inventory-Only Agent devices.

Troubleshooting the Inventory Workflow

If you are unable to view the devices in ZENworks Control Center:

1 On the Primary Server, check the files in the <Installed
Path>ZENworks\work\collection\inventory zipped folder to see if the loader is running.

2 If the loader is running, verify whether any PRU deploy or KBMerge process is also running as
this stops the processing of WIF files until the process completes.

3 If none of these are running, check the loader-messages.log to see if you find any log
message stating that the PRU version is not in synchronization with the LMPRU version. Apply
the PRU as the LMPRU to ensure that the PRU versions are not in synchronization.
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B Troubleshooting Asset Inventory

The following sections provide solutions to the problems you might encounter with Novell
ZENworks 11 SP3 Asset Inventory:

¢ “The ZENworks Adaptive Agent on NetWare is unable to send inventory to the ZENworks
Server or obtain settings from the ZENworks Server” on page 119

¢ “LDAP import tasks remain in a pending state if they run simultaneously” on page 120

¢ “An inventory-only managed device is unable to post scans” on page 120

¢ “Inventory data of a managed device is not displayed for the Linux Primary Server” on page 120

¢+ “How do I enable debug logging?” on page 121

¢ “Unable to import the inventory data gathered with the Portable Collector in ZENworks Control
Center” on page 121

¢ “Inventory data of a device reregistered from one Management Zone to another is not
displayed” on page 121

¢ “Event-based and On Refresh schedules fail for the inventory scan and collection data form” on
page 121

¢ “Inventory reports list duplicate components during an inventory scan in ZENworks Control
Center” on page 122

¢ “Unable to inventory the BIOS details for Windows 7 64-bit devices that have SMBIOS 2.0 or
earlier installed” on page 122

¢ “An inventory-only managed device is unable to post scans on Macintosh OS X" on page 122

¢ “KB Merge failure might occur when Primary Servers are on different operating systems” on
page 122

¢ “Optional fields are not visible in the LDAP Fields list in ZENworks Control Center” on
page 124

¢ “On some Windows devices, the Usage Module Helper(zcmumbhelper.exe.) crashes randomly”
on page 124

¢ “From Windows 7 onwards, you might not be able to monitor the usage of Web applications on
64-bit devices” on page 125

¢ “The inventory report displays two entries of the IOA when the IOA is upgraded to 11.3” on
page 125

The ZENworks Adaptive Agent on NetWare is unable to send inventory to the
ZENworks Server or obtain settings from the ZENworks Server

Source: ZENworks 11; Asset Inventory.

Possible Cause 1: The IP address of the ZENworks server is incorrect.
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Action 1: Configure the correct IP address:

1 Inthe sys:\ZENworks\zaa\uiaconfig.xml file, specify the correct IP
address in the following line:

<servers>ipaddress:80</servers>
Replace ipaddress with the address of the server.
2 (Optional) To immediately post the scan, restart the zenaa module.
Possible Cause 2: The network connection or the ZENworks Server is down.
Action 2: Ensure that the ZENworks Server is up and running.
Possible Cause 3: The Primary Server has been configured to run on a port other than 80.

Action 3: Configure the correct port number:

1 Inthe sys:\ZENworks\zaa\uiaconfig.zxmlfile, specify the correct port
number in the following line:

<server>ipaddress:80</server>
where ipaddress is the address of the server.

2 (Optional) To immediately post the scan, restart the zenaa module.

LDAP import tasks remain in a pending state if they run simultaneously
Source: ZENworks 11; Asset Inventory.

Explanation: If an LDAP import task has not finished and you simultaneously run a new task,
the new task is not started and remains in a pending state.

Possible Cause 1: Multiple tasks are running simultaneously.

Action 1: Before running a new task, ensure that all the existing tasks are in a finished
state.

Possible Cause 2: Multiple tasks have been configured to run on the same schedule.

Action 2: Ensure that you do not set the same schedule for multiple tasks.

An inventory-only managed device is unable to post scans

Source: ZENworks 11; Asset Inventory.
Possible Cause: The uiaconfig.xml file might be corrupted.

Action: Do the following:

1 Inthe uiaconfig.xml file, add or change the IP address in the following
line:

Server="a.b.c.d”
Replace a.b.c.d with the address of the server.
On Linux, uiaconfig.xml is located in opt /novell/zenworks/umia.

2 (Optional) To immediately post the scan, restart the zenumia service.

Inventory data of a managed device is not displayed for the Linux Primary Server

Source: ZENworks 11; Asset Inventory.
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Explanation: The inventory data of managed devices is not displayed for the Linux Primary
Server in ZENworks Control Center.

Action: Install the inventory-only agent on the Linux Primary Server. The Linux Primary
Server is listed as an unmanaged device in ZCC (Device > Inventoried).

For information on how to install the inventoronly agent, see “Installing on
Linux” in the ZENworks 11 SP3 Discovery, Deployment, and Retirement Reference.

How do | enable debug logging?

Source: ZENworks 11; Asset Inventory.

Action: To enable the logs, see TID 3418069 in the Novell Support Knowledgebase (http:/
/www.novell.com/support/search.do?usemicrosite=true&searchString=3418069).

Unable to import the inventory data gathered with the Portable Collector in
ZENworks Control Center

Source: ZENworks 11; Asset Inventory.

Possible Cause: In the inventory scan file, special characters such as &, #, or 1 are appended with
the <DateInstalleds> tag. For example:

<DateInstalled>&#l; </DateInstalleds

Action: Do the following:
1 Inthe .xml file from which you want to import the inventory data, remove
all the special characters such as &, #, or 1 that were appended with the

<DatelInstalled> tag and ensure that the tag contains the following
information only:

<DateInstalled></DatelInstalled>
2 Import the inventory data again.

For more information on how to import the data, see Section 3.6.4,
“Importing Data Gathered with the Portable Collector,” on page 42.

Inventory data of a device reregistered from one Management Zone to another is
not displayed
Source: ZENworks 11; Asset Inventory.

Explanation: If a device is reregistered from one Management Zone to another, the inventory
data is not displayed for the device in ZENworks Control Center.

Action: Initiate an inventory scan twice on the device.

For more information on how to initiate an inventory scan, see “Scanning the
Device” in the Novell ZENworks 11 Adaptive Agent.

Event-based and On Refresh schedules fail for the inventory scan and collection
data form

Source: ZENworks 11; Asset Inventory.
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Explanation:

Action:

If an administrator configures an event-based or On Refresh schedule for an
inventory scan and collection data form, the inventory agent fails to invoke the
inventory scan and collection data form.

Configure only a Recurring schedule for the inventory scan and collection data
form.

Inventory reports list duplicate components during an inventory scan in
ZENworks Control Center

Source:

Action:

ZENworks 11; Asset Inventory.

To troubleshoot the issue, see TID 7003350 in the Novell Support
Knowledgebase (http://www.novell.com/support/
search.do?usemicrosite=true&searchString=7003350).

Unable to inventory the BIOS details for Windows 7 64-bit devices that have
SMBIOS 2.0 or earlier installed

Source:

Explanation:

Action:

ZENworks 11; Asset Inventory.

If you want to inventory the BIOS details for Windows 7 64-bit devices, you must
have SMBIOS 2.1 or later installed on these devices.

None.

An inventory-only managed device is unable to post scans on Macintosh OS X

Source:
Possible Cause 1:
Possible Cause 2:

Action:

ZENworks 11; Asset Inventory.
The zenumia service does not start the inventory scan.
The zenumia service is unable to run the inventory scan.
Do the following:
1 Stop the zenumia process by running the following command:
SystemStarter stop zenumia

2 Start the zenumia process by running the following command:

SystemStarter start zenumia

KB Merge failure might occur when Primary Servers are on different operating

systems

Source:

Explanation:

ZENworks 11; Asset Inventory.

If there are multiple types of operating systems in an environment and if one
Primary Sever is on Windows and another Primary Server is on Linux, KB Merge
might not finish in some cases. You see the following error message in
ZENworks Control Center:

An error occurred during the KB Merge. If this problem persists,
please contact Technical Support.
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Action: If the first Primary Server is on Windows and the second Primary Server is on
Linux, modify the path names for the second Primary Server:

1 On the Linux Primary Server, go to /var/opt/novell/zenworks/tmp/kb/
pre.

2 The file names currently have the path as part of the file name. Rename the
following files by removing the C:\Program Files
(x86) \Novell\ZENworks\conf\pru\ path:

Change file name from Change file name to

C:\Program Files ship.kb
(x86) \Novell\ZENworks\conf\pru\ship.kb

C:\Program Files pruver.tkb
(x86) \Novell\ZENworks\conf\pru\pruver. tkb

C:\Program Files iv.kb
(x86) \Novell\ZENworks\conf\pru\iv.kb

C:\Program Files LC TallyProduct.txt
(x86) \Novell\ZENworks\conf\pru\LC TallyProduct.tx
t

C:\Program Files LC_TallyProductMap.txt
(x86) \Novell\ZENworks\conf\pru\LC TallyProductMap
.Ext

C:\Program Files LC TallyProductSuite.txt
(x86) \Novell\ZENworks\conf\pru\LC TallyProductSui
te.txt

C:\Program Files LC_TallyProductSuiteMap.txt
(x86) \Novell\ZENworks\conf\pru\LC TallyProductSui
teMap.txt

3 To trigger the KB Merge process in ZENworks Control Center, select
Configuration > Asset Inventory > Local Software Products.

4 Select the products, click Action, then select Update knowledgebase with Local
Product Changes to apply the changes.

Action: If the first Primary Server is on Linux and the second Primary Server is on
Windows, modify the path names for the second Primary Server:

1 On the Windows Primary Server, go to $ZENWORKS_HOME% \ temp\kb\pre.

2 The file names currently have the path as part of the file name. Rename the
following files by removing the /etc/opt/novell/zenworks/pru/ path:
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Change file name from

Change file name to

/etc/opt/novell/zenworks/pru/ship.kb
/etc/opt/novell/zenworks/pru/pruver. tkb
/etc/opt/novell/zenworks/pru/iv.kb

/etc/opt/novell/zenworks/pru/
LC_TallyProduct.txt

/etc/opt/novell/zenworks/pru/
LC_TallyProductMap.txt

/etc/opt/novell/zenworks/pru/
LC TallyProductSuite.txt

/etc/opt/novell/zenworks/pru/
LC TallyProductSuiteMap.txt

ship.kb
pruver.tkb
iv.kb

LC TallyProduct.txt

LC_TallyProductMap.txt

LC TallyProductSuite.txt

LC TallyProductSuiteMap.txt

3 To trigger the KB Merge process in ZENworks Control Center, select
Configuration > Asset Inventory > Local Software Products.

4 Select the products, click Action, then select Update knowledgebase with Local
Product Changes to apply the changes.

Optional fields are not visible in the LDAP Fields list in ZENworks Control Center

Source: ZENworks 11; Asset Inventory.

Explanation: Optional fields defined in the LDAP directory are not visible in the LDAP Fields
list in the LDAP Import Task Mappings panel of ZENworks Control Center.

Possible Cause: The optional fields defined in the LDAP directory are not present in the
dirimport .xml file, which is on the ZENworks Server.

Action: Update the dirimport.xml file with the optional fields. For example, if the
optional field is costCenter, perform the following steps:

1 Locate the dirimport.xml file:

On Linux: /etc/opt/novell/zenworks/loader/dirimport.xml

On Windows: ZENworks HOME>\conf\loader\dirimport .xml

2 Update the optional field in the following lines in the dirimport . xml file:

<Module> <Class>com.novell.zenworks.loader.modules.Inventory

Import Module</Class>

<Parameters>

<Parameter Name="sleep-interval">30000</Parameter>
<Parameter Name="include-field"scostCenter</Parameters

</Parameters>
</Module>

On some Windows devices, the Usage Module Helper(zcmumhelper.exe.)

crashes randomly

Source: ZENworks 11; Asset Inventory
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Explanation:

Action:

On some Windows devices, ZCMUMHelper . exe which collects the web usage,
network usage and other details of the logged in users might crash with a pop-
up message.

Rebooting the device might fix the problem.

From Windows 7 onwards, you might not be able to monitor the usage of Web
applications on 64-bit devices

Source:

Explanation:

Action:

ZENworks 11; Asset Inventory

On 64 -bit devices from Windows 7 onwards, you might not be able to collect or
monitor the usage of the Web-based applications or pages.

There is no workaround.

The inventory report displays two entries of the IOA when the IOA is upgraded to

11.3

Source:

Explanation:

Action:

ZENworks 11; Asset Inventory

The Inventory Only agent (IOA) updates or upgrades itself as soon as the
Primary server is upgraded from 11.2 to 11.3. The inventory report displays two
entries of the IOA i.e both 11.2 and 11.3, instead of only 11.3.

There is no workaround.
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Documentation Updates

This section contains information on documentation content changes that were made in this Asset
Inventory Reference for Novell ZENworks 11 SP3 Configuration Management. The information can
help you to keep current on updates to the documentation.

The documentation for this product is provided on the Web in two formats: HTML and PDF. The
HTML and PDF documentation are both kept up-to-date with the changes listed in this section.

If you need to know whether a copy of the PDF documentation that you are using is the most recent,
the PDF document includes a publication date on the title page.

The documentation was updated on the following date:

July 2014; Update To ZENworks 11 SP3 (11.3.1)

Location Update
Appendix B, “Troubleshooting Asset Inventory,” on Made updates to the following troubleshooting
page 119. scenario:

+ “Optional fields are not visible in the LDAP Fields
list in ZENworks Control Center” on page 124
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